Tachoscan Con’rroW
INELO

Check procedure manual

Version: 7.1.0




/4
INELO

V/ 4

TachoScan Control

Check procedure manual

© 2002 - 2024 INELO Polska Sp. z o.0. All Rights Reserved

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical,

including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the
publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners.
The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility
forerrors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs
and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other
commercial damage caused or alleged to have been caused directly or indirectly by this document.

The program windows (screenshots) shown within this help file can differ in form and contents from the actual program windows.
This can be the case especially when the program version differs from the manual version.

Production:
INELO Polska Sp. z o.0.

ul. Karpacka 24/U2b
t
#3133¢Bielsko-Bia a

www.inelo.pl




/4
INELO

V/ 4
Table of Contents

B 141 o Yo [Tt doT VAN o o o IR PPRON.
B\ T3V ol 41 o | RS & |
Entering of data .....ccoveieiiiiiii e s s ee e seeensneeees 10

A W N =

..4.1. Scanning the record sheets 17
B o o =14 =T [T T4 1= TP O OO OO PP PP PP PP PPPPP PP 18
B A (o 1 Yot o =Y T OO P PP OPPPT PP 19

81,3, Set the record SHEET STArt LIME ...uiiiieiieee et e et e et e e s it e e e e ab bt e e s abb e e e eabt e e e eabb e e e sabeeeesnneeeeannne 20
B 1A RECONT SNEET TATA ..eviiiiiiiiiiiiii ettt et e e 23
B T (=T ol T o B =TT Ao 1 o] 14 o F T TP P PP OPUPROPPRRON 24
B Y L LU 1 LAV o o BTt €AV =T 26

..4.2. Download from driver card 29
B W o ¢ XV TV e T e e = =Y L o o PP 29

..4.3. Downloading data from tachograph 37
B e T =Tl o =T Vo [T o = T o TSP TSP P OPPRTOP 37
ceeeeh.3.2. TAChOREAAET COMDO PIUS ..ttt ettt st e e bbbt e bbbt e st e s eabe e e s abe e e s aabaees 37

..4.4. Open from afile 37

..4.5. Correct reading of data from the driver card/ tachograph 38

..4.6. Corrupt reading of data from the driver card/ tachograph 40

..4.7. Import of data from tachograph to the card 40

5. Preview window of data from the digital tachograph ........c.ccccceevnvenneenee... 42

..5.1. General and technical data 42
..5.2. Activities on a specific day 43
..5.3. Events and faults 45
..5.4. Activities, events and faults in the table 45
..5.5. Card insertions and withdrawals 45
..5.6. Company locks and last download 46
..5.7. List of controls 46
..5.8. Speed profiles 46
..5.9. RPM profiles 47
..5.10. Speed chart 48

6. Data VerifiCatioN ...cceieiirieiieierieteeierentereeseecessosessesessessassssessassssessnsessessssesssse D3

..6.1. Lack of driver's records 53
..6.2. Infringements and manipulations 54
B 30 20 B U LY < o 0T Ao = [ V7Y o= o SR 63




+....6.2.2. Driving WithOUt @n @PPIrOPIIAte CAIG ....ueiieeeeiiiiiiie e e ettt e e e et e e e e e e st eaeeeae e e s saeeaeaeeaaasseeseaaeeaaanssseeeaeeeaannnsnsaaaeeeannssnneeens 66
.....6.2.3. Compare driving time and distance 0N the Map ..o 71
..6.3. Presentation of iINfrINGEMENTS ...ccciiiiiiiiiiiiic e e e s e e s e s e s s e s e s e s e e s s s e s s s e s eeeeeeeesesnennanns 73
B S B IRV 1YY Yol o - Y USRS 73
8.3, 2 MIONTRIY ChArt o 77
B S T T 0 Y o e =Y o PSSR 79

7. Locking and exporting of control ........ccccceiieiiiiiiiiiiiiceiiniceenrcenreseeeenneees 81
8. Unlocking and editing of control ........c.cceiieiiiiiiiiiieiiiiiicccrcrececrececeeeneee. 83
1 I CT=T o YT 1 [ o ¥ =g =T o Lo o 86




/4
Introductory note INELO

/4

1. Introductory note

This Manual has been drafted in order to familiarize users with the general manner of conduct
during on the road control and during control realized in company premises. New users are
recommended to start the TachoScan software and try out the operations as they are presented,
whereas, those users that command already some experience in working with the software may, straight
away, proceed to a given level of their choice.

Saying all this, the Manual is especially targeted to those persons, which had no previous contact
with read out of digital driver cards and of tachographs in the TachoScan software, and thus, every
single stage is meticulously portrayed.

Usually, initial control assumes the following pattern:

Logging in;

New control "parameters" setting;

Entering of data from tacho disco and/or driver cards;

verification of tampering;

Reporting and approval of offences;

Control locking and exporting;

Control unlocking and editing.

The Manual portrays the realization of all of these stages with the use of exemplary data.

Details of the drivers, controlled companies, driver card numbers and vehicle registration numbers are fictitious.

2. Signing in

Before you start to work with the program you should log in first. To log in, select the appropriate
user icon on the login screen, and then enter password, if required.

Expert license:

The first login is made using the User account without a form. There is no administrator account - editing can be
done from the level of any user. During subsequent logins, the previously logged in user will be selected. Adding a
user requires entering only the name and surname (without a password), additionally a check is made whether the
entered user already exists in the database.

First login (Administrator)

When you log in for the first time, the program displays the following window:
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< User *

Mo users have been defined for TachoScan Control. Click "Add a

o user" and create a new account to be able to create a new
Administrator control

Fig. No user - Message.

in which you need to click on the administrator icon, and then, in the next window:
e fill in the Password field (the default password is "admin");

. Sign in
e click -

< User >

K3

Administrator

o

Language |English ~

Once logging in is successfully completed, the software shall be activated.

New user

When logged in as an administrator, from the control menu, select: Add a user.
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< Controls menu x
Data analysis

| |Cnntinue last control ‘ .: ‘Sw‘rtch user

|+§ |Hew control | .u|chagg password

=) AR |

l-"}. DSRC ‘ .+.|Adda user

" "y

|%| Edit/view selected control | .f| Edit user

| %|Ex rt selected controls | ._|Delete user

‘ &‘Setaﬁrectnriﬁ |r’¢|mh§|ssethu§

|‘~¢|P ram setti
Archiving data

| %Pmp_nrtmntmls ‘ ‘Checks statistics for EU

‘I.Iselsact'w‘
|o| About... |o| Exit program

Fig. Administrator control menu.

The program displays the Add User window.
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< Add auser *
| Next | Save | Close
User
Last name First name
[ | |
Active
Password required

[ authorization only for their own controls
Authorization for deleting control
Archive control data before deleting
Authorization for reopening control

Permissions to edit program paths
Password (Minimum & characters)

Rank *Identification number

Province

Settings edit privileges
Tolerance

Analysis

Warnings

Default type of new contral
(O contral on the premises

(® roadside check

Fig. Administrator - adding a user.

We enter, accordingly (see: "User" -> "Add" topic for more):

e Surname and name;
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domain.

LAN License - Domain authentication ("Settings" -> "Program settings" menu):
Surname and name (login) of the TachoScan Control user must be the same as the username in the

e Password required - uncheck this option if you don't want the user to supply a password

at login;

e Authorization only for their own controls - if checked, the inspector will see only the checks
he/she has set up (significant for LAN licenses);

e Password - if the above-mentioned option is checked;

e Rank;

e |dentification number;

e Province - select from the list;

e Settings edit privileges - select the tabs which the user being added or edited can access;
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Wyjatek:
Kazdy z uzytkownikow niezaleznie od uprawnieri zawsze bedzie miat dostep do zarzgdzania opcjg: After
reading the driver card data insert 1-minute work at each place entry (zaktadka: "Analysis")

o Default settings of a new control - select the type of check you want to select when setting
up a new check.

Example

@ Add a user X

=

User
Last name First name

|Analyser | |Frank |
Active
Password required

[ authorization only for their own controls
Authorization for deleting control
Archive control data before deleting
Authorization for reopening control

Permissions to edit program paths

Password (Minimum & characters)
| L1111 ]] |

Rank *Identification number
|Inspev:hor | | 1234E| |
Province

Settings edit privieges
Tolerance

Analysis

\Warnings

Default type of new control
(O contral on the premizes

(® roadside check

Save Close

After the foregoing data are completed, press: and then button.

Then, the Controls menu window shall appear, again:
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< Controls menu *
Data analysis
S ==
| % |Cnntim|e last control | (I | Switch user
= L}
| +§ New control | .U|cha ssword
L= AR T
.-"}.|DSRC | .+.|Adlla user
— —
f‘é | Edit/view selected control | .-"|Edit user
L AR
|%1 Export selected controls | ._|Deleteuser
L) AR
| '%.|Setdirectori5 | ﬁ|ﬂnamissettig§

| ﬁ | Program settings

Archiving data

| %Pmp_nrt controls | @ |Checksstatisﬁcsfnr EU

Users activity

|6| About... |6| Exit program

On the list, we click on the option: Switch user.
In the new window, click on the inspector icon, and then type your password and click
Sign in

(Controls menu window is shown again to allow to add a new check)

10
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@ User *
[ =]
(=]
W
[
Administrator Analyser Frank
Rank:  Inspektor
Identification number:  1234E

@ User

Analyser Frank

S —

Language and tariff |English ~

3. New control

Expert license:

The nomenclature of "Expertise” instead of "Control"was introduced throughout the program.

Each control performed by TachoScan Control is recorded in the database, so when you select New
control you need to enter the data specifying: control no., date, name of the controlled company and

the type of control carried out.

To start a new control:
e in Control menu select New control;

or

% , and then, in Controls menu window, select New control.

e click on:

11
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< Controls menu >
Data analysis
Continue last control | .1—|Switch user
& aa
‘ | +E% |Newcontrol | %|Ex rt selected controls
|I"}|DSRC | %|Setdirectuﬁ5
|%| Edit/view selected control |‘~a|P ram setti
Archiving data
| %ngn controls | |Checksstatisﬁes for EU
‘ Users activity
|o| About... |0| Exit program

The program displays: New control window which contains the following elements:

12
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< Mew control o
Mew control parameters

Nurnber Date

|0003-2021-12345 | 5 |r0s-2021 v |[15:40 2]

Company name

Identifier/Tax Id Country

Licence number

Cargo Controlled period:
' goods 'v| 24082021 ~|- 21032021 ~
() contral on the premizes (®) roadside chedk
[ Imark all drivers data as confidential {in reports)
Driver name Card no
¥ | v]
Co-driver's last and first name Card no
| v] | v]
Registration nation Vehide registration
|L.Ir1ited Kingdom e | | e |
Type of road Type of tachograph
| V] | ]
Lack of records for other wark and/for availability EI
Driving and warking time records EI
Recording equipment: incorrect functioning, misuse EI
Time zone:
|L.ITC (Ireland, Portugal, United Kingdom) e I
[ indude daylight saving time Remember [_]
Average weekly working time | Define periods |

New control parameters:

1. Number - the program automatically assigns a number for each control:

e the first part 0208 is the consecutive control number, which can be changed using arrows on
the right;

- A y 4 13
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¢ the second part 2014 is the current year read from the Windows system date;
e the third part 1234-1234 is the identification number of the logged inspector.

2. Date - this is the control date, by default the current date read from the Windows system date is
displayed.

3. Company name - enter the name of the controlled company or, for driver control, the company he
works for.

4. Cargo - in this window, select the type of carriage from the list: goods, passengers or
unspecified.

5. Controlled period: — select a range of dates between which the control is to be carried out.
By default, the program sets a controlled period of 28 days plus the current day

Data downloaded from the driver card and digital tachograph outside of the specific range are NOT analyzed and
are NOT saved in the database.

If you change the "controlled period" you need to download again the driver card data and/or data from the
digital tachograph and re-analyze the drivers'infringements.

The period of infringements analysis may also be limited to the period of employment (see "Driver" -> "Add" topic
for more).

Immediately after downloading data from a driver card/ digital tachograph, in the daily chart
preview window, days outside the control period will be "grayed out" with an appropriate message (see:
fig. ci-dessous).

Driver's dally chart

| 04:28 | @

]
el
the question mark. I I I a

6. Selecting the type of control:

e control on the premises:
» Carriage purpose — choose a purpose from the list: own purposes or earning.
» the control is divided into a driving time and rest periods control, and work time control -
the Swedish language version
e roadside check:
» Driver name;
> Vehicle registration;
» Co-driver's last and first name — driving in a team;
» Registration nation.

If data is retrieved from the driver card, this data is automatically filled in.

» Type of tachograph.

7. Mark all drivers data as confidential (in reports) - if this options is checked, all personal data will

Ay 14
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be hidden on the reports.
8. Depending on the results of the checks carried out, fill in the following fields (data entered in the
fields below are displayed in the report: "Checks statistics for EU"):
e Lack of records for other work and/or availability;
¢ Driving and working time records;
e Recording equipment: incorrect functioning, misuse.

9. Time zone: - the local time offset against UTC - when you retrieve the data, the program moves all
times read from the driver card data and the tachograph against the time zone set in this option.

“ TachoS5can 4.0 Control

Contrel Data Reports Document Company
Control Retrieve |

SO

current contral Drriver card _ _ 4

Driver Driver's daily chart
Ap——l] 531

Day
o (26-10-2014 [El~ |/ >

Vehice

WEM w E

Km initial Km final

P
ol

Fig. Daily driver chart (2:1 scale) - time shift.

15
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& TachoS5can 4.0 Control
Control  Data  Reports  Document  Company  Weh

Control Retrieve dat:
— +* 1}
IS
Current control Drriver card

Week @® Driver
26-10-2014 - 01-11-2014

16:05 e |

Sunday l

26.10,2014 AH
I Sl gl b

Fig. Weekly driver chart - time shift.
¢ Remember - the option allows to save the choice of the time zone. If the option is enabled, the
last saved time zone will be hinted while creating a new control. The option is disabled by

default.

By default Time zone: and Include daylight saving time option will be set based on the country selected in the
Registration nation field;

After downloading the digital data you can not change the time zone. The change is only possible after the
removal of all digital data of the current check. The simplest solution is to remove the current check and to open a
newone.

UTC (Coordinated Universal Time) - standard time determined based on TAl (French: Temps Atomique
International), taking into account the irregularity of the Earth's rotation and coordinated with the solar time.

10. Average weekly working time Define periods - Allows to set any dates for the analysis to
be carried out in the: Driver's average weekly working time report - detailed report.

Fields marked with blue frames are required.

4. Entering of data

The TachoScan Control software makes possible the control of entrepreneur or driver, who
simultaneously uses vehicles carrying digital tachographs and analogue tachographs. Then, the
TachoScan software analyses all data and combines it appropriately.

16
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4.1. Scanning the record sheets

Record sheets can be scanned on two types of scanners: flatbed[ s 1and rolll 19 1scanner.
Default settings

The default settings make it easy to enter new record sheets in the program, because the
program can automatically fill in the appropriate fields with predetermined values.

—

Default settings window is opened using: icon.

Elements of the window:

1. Driver - Set the default driver.
When you select this option from the drop down list, you can select a driver that will be
displayed in the appropriate field in the record sheet view/edit window.

2. Vehicle - Set the default car
When you select this option from the drop down list, you can select a vehicle registration
number that will be displayed in the appropriate field in the record sheet view/edit window.

Use the + button to add a new driver or a car to the database.

3. Date and time:
e Default disc date - the program will assign the date specified here to all scans;

¢ Start time - means the point of time from which a day (twenty-four hours) is calculated by
default on the disc.

Scanning settings

The "Program settings" window includes, among others, settings for the scanner. If you select
Show the settings option, scanning settings appear before every scanning. If you use a scanner
different than the one recommended by INELO Polska Sp. z 0.0., scanning settings appear
irrespectively of this option.

Recommended scanners: Canon LiDE 70, LiDE 100 or LiDE 200, Plustek SmartOffice PS283.

Settings for other scanners:

Recommended scanner settings (Program settings window):
e resolution 300 dpi;
e brightness -20;
e color — black — white;

17
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e scanner lid background color: Black.

Brightness

Setting higher brightness can improve the quality of reading on dark discs. It contributes to a
clearer image. At the same time, additional points (distortions) having an influence on the later
analysis of the disc disappear. If some points are not recognized by the program, you should add
them manually on the tab "Read preview". If the reading is still incorrect, you should try to set other
brightness once again.

False points Correct points

Fig. An example of a scanned kilometres graph.

4.1.1. Flatbed scanner

To start the scan process, place a certain number of discs (1 to 6) in the scanner so that all are
placed in the scanning area (A4 area). No special adapter is needed for proper scanning. Discs can be

arranged in any way.

18
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Red rectangles mark the disc sections considered in the analysis.

Discs on the scanner must be placed facing down. The example above shows the discs as seen from the
scanner glass side.

When you place a disc, close the scanner cover to limit the number of possible inaccuracies.
Scanning can be started in three ways:

e choose: "Get -> Scan" from menu: Data;

e click the |g| button on the toolbar;

=W~
e use the = shortcut.

After scanning, the program will open the last record sheet in the record sheet preview edit tab, and
the rest will be displayed in the Unsaved discs panel. Each record sheet should be reviewed, data should
be completed and saved.

For a detailed description of the record sheet preview/edit form refer to the topic: Analysis of scanned discs.

4.1.2. Roll scanner

To start the scanning process, place a certain number of discs (max. 50) in the scanner feeder, so
that they are all directed with the graph to the inside of the scanner. The record sheet discs should not
be placed in the center of the scanner - they should, for ex-ample, be moved to the right (fig. ci-
dessous). The angle of rotation of the disc teardrop is not important (fig. ci-dessous).

The scanner jamming after scanning half of the disk may result from placing it centrally in the scanner. Place the
disc unsymmetrical fig. ci-dessus and retry scanning.

When you place the disc in the tray, you can start scanning using the following methods:

- A y 4 18
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e choose: "Get -> Scan" from menu: Data;

e click the "™ button on the toolbar;

Alt s
e use the u + l—l shortcut.

After scanning, the program will open the last record sheet in the record sheet preview edit tab, and
the rest will be displayed in the Unsaved discs panel. Each record sheet should be reviewed, data should
be completed and saved.

For a detailed description of the record sheet preview/edit form refer to the topic: Analysis of scanned discs.

4.1.3. Set the record sheet start time

Start time is the time the driver first inserts the record sheet into the tachograph or the start time of
manual entries (on the back of the record sheet). It is represented by the purple line from the centre of
the disc. It can be changed on each tab containing a scanned image of the disc (Read preview, Basic
data).

Starting hour can be changed in two ways:

Using the option: "Change the time of starting”

20



Entering of data INE

Add
Delete

Change to
Refresh km points for the selected driving activity

Reanalyze record sheet

Change the time of starting
Advanced

Second vehicle

Ferry/train

1. Move the mouse cursor to the place of the first insertion of the record sheet into the tachograp
(fig. ci-dessus).

The clock in the upper left corner of the image shows the time over which the cursor is at this moment.

2. Right-click in the same place and then select: Change the time of starting (fig. ci-dessus) from
the drop-down menu.

3. Purple line (start time) will be moved to the selected location (fig. ci-dessous).
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Exception:
If you select the start time place within a driving event, the program will automatically move it to the
beginning of the event.

Moving using the mouse

This method works only in the Basic data tab.

Moving is possible only within a single event on which the purple line is placed.

1. Place the mouse cursor on the purple line, so that the arrow is changed into: b

22
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2. Click and hold the left mouse button, then move the purple line to the desired position.

4.1.4. Record sheet data

To save the record sheet it is required to specify the date, driver and vehicle.

To take full advantage of the program it is recommended to complete all the data:

Date

Enter the start date of the record sheet.

Driver and vehicle

These fields should be filled in using the drop-down lists besides. If the required values are not

included in the lists, use ‘! buttons to complete the database. If the default vehicle was set for the
selected driver (add/ edit driver window), it will appear automatically in Vehicle field, if it was
empty.

Odometers

In Km initial and Km final fields enter the initial and the final reading of the odometer of the
vehicle (the numbers entered by the driver on the disc). Then in the Difference in km box below,
the difference of kilometres is shown, which is the distance travelled according to the driver. If the
calculated distance differs too much from the number of kilometres read by the program from the
disc, located in Sum of kilometers field, these fields will be automatically highlighted in red.

Tolerance of km difference is in "Settings -> Analysis settings -> Tolerance tab" in the Alert if km
distinction greater than field.

In the Read preview tab, the program draws a thin red line to check whether the kilometres
reading was correct. If the red line does not coincide with the black one drawn by the tachograph,
re-scan the disc with other brightness settings or correct the position of peaks manually.

Team disc

The Team disc field should be checked for discs from the drivers driving in a team. Selecting
this option results in a different analysis of the data in accordance with the respective regulations
for drivers driving in a team.

23
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4.1.5. Record sheet calibration

If you think that the program misread the start time of activity on the record sheet, check if 12:00
o'clock is set correctly.

"12:00 o'clock” setting can be changed only in Basic data tab.

"12:00 o'clock" can be changed in two ways:

¢ right click anywhere on the record sheet image (fig. ci-dessous), and then, from the drop-
down menu, select Advanced -> Set 12:00 hours.

Delete

Change to r I
Refresh km points for the selected driving activity f’ J";
Reanalyze record sheet FE
Change the time of starting i j

Advanced Set 12:00 hou F10

Second vehicle [/ ¢ Remove all oth -
Remove all avai

Ferry/train

F10

e press

Colour markings are removed from the disk image and the red circle appears to mark the position
of the "12 o'clock” on the record sheet, the window showing the angle of deviation of twelve o'clock
and auxiliary lines indicating the hours on the disc (fig. ci-dessous).

- A Ay 2
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12:00 4 M. angle kmk

(wjie0 (&

To change the position of "12:00 o'clock," click and hold the circle with the left mouse button (fig.
ci-dessus), and then move the mouse to set the circle in the new position.

As you move it, the clock in the upper left corner of the image will be replaced by the number of degrees.

25
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1200 4.M. angle
180

Fine adjustment can be made by pressing the appropriate buttons (fig. ci-dessus) in 12:00 A.M.

angle window.

The correct setting of "12:00 o'clock"” (always in the thinner end of the teardrop) is achieved if the auxiliary lines
coincide with the hours on the record sheet.

4.1.6. Manually add activities

The program allows you to add activities manually. You can use this option if the driver during the
inspection provided record sheet or printout from the tachograph, on which he drew activities by hand

(fig. ci-dessous)

26
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To open the window of manual adding of the activities, choose one of the following options:

[ +
e press the combination of keys;

e from the main menu Data select the Add manually option.

- A y 4 27
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In the Manual adding discs, provide the following information:

L B’
< erereony I S

Disc data Events data
Driver

Event's parameters
|K'3‘"“"E'|5l‘:i Jan E“ | s | Event type Time from  Time to Km
0]

Vehicle | driving v | [o0:00 | oow0 (2

58 0ASD2 o] (=] | save |

Date From il Time Km Mode =
25082014~ » I N N .

Starting time

Lok |

o000 =
Km final
0

Km initial
0

Difference in km

[ 9

Disc Annotation

@ digital ) analog -
team

1. Driver (fig. ci-dessous);
Vehicle;

Date of starting the "record sheet/ day from the driver card”;

> wn

Start time of the "record sheet/ day from the driver card"”;

Changing the day start time after adding the events is possible after their removal.

Click | Zapisz |

The final and initial number of kilometres;

Km difference - is calculated automatically;

© N o w

Select the type of data presentation: analogue or digital;

- A y 4 28
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9. Alternatively, check the team field;
10. Annotations - here you can enter additional remarks;

11. Detailed data - events - contains a list of activities for the specific day, which should be filled in:
e select the event type;

e time from - is automatically filled in based on the start time of the day, and in the following
items on the basis of the end of the previous event;

e time to - end time of the activity;
e km - for driving events you can enter the number of kilometres travelled;

o clicking | 9% will add the event to the list.

The total duration of all events must be equal to 24 hours.

4.2. Download from driver card
To download driver card data, it is required to install and connect the digital card reader.

Retrieving data, after inserting a driver card to the reader, can be started in three ways:
e select: Get -> Scan from the Data menu;

i
e click the & button on the toolbar;

At c
e use the lA + l— shortcut.

Subsequently, data analysis may proceed in two ways :
e Correct reading of data from the driver card/ tachographls'}

e Corrupt reading of data from the driver card/ tachoqraphm

e Corrupt reading of data from the tachograph.

If you have downloaded the data from a driver card that is registered as canceled, the appropriate information that
such card was detected is displayed.

4.2.1. Preview and data edition

The top part of the edition window in digital discs contains the following elements:

Driver's daily chart

Basic data
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Driver, Date, Vehicle, start and end km counter status.

1. If on a given day, a driver rode more than one vehicle, you can shift between activities
connected with a given vehicle, choosing the appropriate registration number in the
Vehicle field.

2. Changes of date in the Day field causes a shift to the card of a chosen driver from a given
day, if it is in the database. Otherwise, instead of an activity graph, the sign No data will
appear.

3. Choosing a different surname in the Driver field causes the closing of data edition of the
previous driver and a move to data edition from the card of that driver.

4. Arrows: 4 allow to move the chart by an hour back and forward. Moving the chart even
by an hour results in hiding of Overview column as well as initial and final kilometers. This
information is only available when we present the whole day from the tachograph and in
the tachograph'’s data there are saved initial and final kilometers.

The choice of date or driver with the driver's card has a completely different meaning than with an
analogical disc.

Activity marking

J 2 a h - 2
Card Other work J Availability J Break/rest J Manual entry Manual entry
withdrawn ( ‘program) ( tachograph)

Fig. Graphical preview of the day from the driver card.

Tea m
.f rom l'he
tachograph

Legend | ptton below

Other markings are described in the program legend window (
the list of activities).

Special signs

¥ - inserting the card, with the country code;
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.2 - removing the card, with the country code;

° - vehicle location marker, with country code (for smart tachograph readings).

The location for smart tachographs is checked every 3 hours of accumulated driving time,
when inserting and removing the card.

The card insertion marker will change color to blue if moved.

Manual entry of a change of location without removing/inserting the driver card is not
properly recorded by some tachographs.

In such a case it may happen that the chart can show a few card removals in a row, with
the change of location, and similarly a few insertions in a row with the change of location
of the card.

Adding, editing, deleting entries of start and end countries

Adding:
1. Uncheck: editing blocked.

2. Right-click in the place of entering the country - select: Insert -> Place entry from the
drop down menu.

3. In the new window, select Country at the beginning or Country at the end, and then
select the country.

Ok

4. Click - the program will insert a blue entry mark.

Editing:
1. Uncheck: editing blocked.

2. Click and hold the left mouse button on the entry mark and then move it to the desired
position (fig. ci-dessous).

Driver's daily chart -\ [ editing blocked
11:28 /
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Removing:

1. Uncheck: editing blocked.

2. Right-click on the country entry mark that you want to delete and then select: Delete from
the drop down menu.

Select an area

Select an area by placing two vertical brown lines on the chart (fig. ci-dessous). In the
Selection tab, you can view the sum of the activities from the selected area. These lines are
placed by single-clicking the left mouse button in the selected place.

Sum of kilometers: 1428
Average speed: 78,5

Fig. Selecting the area.

If the selection includes a driving event, the program will display a tool tip with the total
mileage and average speed (item 1 - fig. ci-dessus).

Selection can be removed by right-clicking on the chart and selecting the menu option:
Remove selection line or Remove all selection lines (fig. ci-dessous).

7 Undo Crl+

[«7  Undo all Shift+ Chrl+

[ ]

* Remaove selection line
Remove all selection lines

v Bind the selection line to events' edges

Fig. Removing the selection.

In the drop-down menu, there is the Bind the selection line to events' edges option
(fig. ci-dessus) - if line is dragged near the beginning or end of an activity it allows to
snap it automatically to the beginning or end of the activity, respectively.

drop-down menu (editing enabled)

Available options (general):
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e inserting a new activity;

e change and deletion of highlighted activity;

e change of all activities card withdrawn for Stopover;

e setting an event as a team or non-team event;

e change of all activities card withdrawn lasting less than 5 minutes for Stopover;
e marking a driving event as driving onto a ferry or train;

e inserting place entry;

e inserting OUT period in selected range or for the entire control ;
e inserting AETR period in selected range or for the entire control;
e deleting the vertical line of the highlighted area;

e deleting all things highlighted in the area;

¢ moving data from a digital tachograph in place of a Card Withdrawn (if a preview of
one of the tachograph slots is opened and the event card withdrawn is chosen);

Ctril |Z
Each change can be reversed by pressing l— + . Multiple pressing of this

combination will reverse a determined number of last changes.

Add, edit, and delete activities

The program allows you to add, move and delete activities downloaded from the driver card.

If the following text is displayed.: Select a vehicle so that you can edit data it means that on the given day
the driver has records for at least two vehicles. In such a case, the following changes occur in the window:

- initial and final mileage counter is hidden;
- button: [Change vehicle] is blocked;

- in the list of activities, in summary, in the location window, in the events and failures window and in the
annotations window, records for all vehicles will be visible (if you specify a particular vehicle, in these windows
only records for this selected vehicle will be visible).

To unlock the above elements, choose a specific vehicle registration number in: Vehicle field.

Edit activity

When you hover the mouse over the border between two activities (the cursor changes

onto the following: " M fig. ci-dessous) press the left mouse button and holding it (item 1)

move the boundaries of the activity, and then release.
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L

Driver's daily chart [ editing blocked
12:32
. A
2 3 4 5 [ 7 [ ) 10

Fig. Moving activities.

To change the type of activity, right-click on the edited activity, then in the drop-down
menu select: Change to and select the type of activity.

If the driver does not change card withdrawn records in the tachograph, the options
useful in supplementing these activities are:

- "?" shorter than 5 minutes to a break;
- All "?" to a break.

Adding driving activities to the driver card based on detailed speed or instructions
registered on the tachograph

1. To add a driving event or other work event, right-click and select Insert activities from
the drop-down menu.

2. Please select at least one option.
e Insert driving / other work activity when the speed is registered while parking in slot 1;
e Insert driving / other work activity when the instruction is registered in slot 2 while

resting in slot 1;

3. In the Apply for: section, select the scope of the functionality:
e For the selected area;
e For the selected day;
e For the whole control (change only for the currently selected driver).

4. Confirm OK

Add activity

Select Insert from the drop-down menu, then select the type of event as well as start and
end time.
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Delete activity

In order to delete an event, right-click on it and then, from the drop down menu, select
Delete.

The deleted activity is replaced with the activity following it.

When editing charts, the possibility to zoom them using the: W button on the right side of the

chart, is handy. Using the — button allows to zoom out the chart, and the W button resets
the chart to its default size.

The icons above are used to scale all the charts simultaneously.

If for the edited day we have a reading from the digital tachograph (the same vehicle), it is
possible to copy data from the tachograph instead the card withdrawn event ("? ") - option:
Copy events from tachograph - slot 1.

Options
Driving in a team

If in the edited day team activities occur and the program discovers data from a second

driver's card for that day, the activity preview option of that driver is activated — button Q .
Pressing this button causes the appearance of a graph of the second driver of the team, but
non-editable. The option of moving to edition of a day of the second driver of the team is also
activated — button [Edit] below.

Preview of activities from the tachograph

If for a given day and vehicle the program discovers in the database data from a digital
tachograph, the option of event preview read from both tachograph slots of that vehicle is

S1 S2

activated — buttons and . Pressing one of them will result in displaying the activity
chart for a given slot. The option of moving to edition of a day from a digital tachograph is
also activated — button [Edit] below.

After hovering over the selected activity registered in the tachograph, a hint containing in-
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formation about the driver and his / her card number will be displayed.

Speed chart

81
After clicking below the activity chart, the following option is displayed: I Speed

chart- show / hide the Speed chart downloaded from the tachograph.

The chart is displayed if speed data were collected for a given vehicle.
Dotted line indicates the authorized speed.

The program downloads and stores in the database the speed if Save detailed speed from digital
tachograph option is selected in the program settings window.

Digital tachograph records in its memory speed over the last 24 hours of driving.

There are warnings o

If this text is displayed in the bottom of the window, it means that the program has
detected irregularities associated with the use of the driver card in the open readout - left-click
on this text to display a list of irregularities: ("Manipulation warnings" tab of "Infringements and

manipulations [sa" generation windows).

The analysis is based on the settings in the: Analysis settings window, "Warnings".

Button: a . Weekly chart

for a description refer to the section: "Weekly chart[71".

Button: & Print activities ¥

for a description refer to the section: "Printing activities".

Button: & Print pictograms

for a description refer to the section: "Print pictograms".
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4.3. Downloading data from tachograph

TachoScan Control software includes tools that enable automatic data downloading from digital
tachograph using the following devices:
e DBOX;

TachoDirive;

Optac;

DownloadKey;
e TachoReader Mobile II;
e TachoReader Combo Plus.

Installation, configuration and the data download routine for the above listed devices is described in
detail in the document: External devices - tutorial.pdf attached to the program installation CD.

Below there is an additional description of how to use devices: TachoReader Mobile Il and Combo
Plus.

4.3.1. TachoReader Basic

De gebruiksaanwijzing TR Basic bevat een beschrijving van de configuratie en het downloadverloop
m.b.t. gegevens van de tachograaf en de bestuurderskaart en zit in elektronische vorm bij het
toestelgeheugen.

De huidige gebruiksaanwijzing is beschikbaar (te downloaden) op onze website:
"https://tachoscancontrol.com/en/" in the: "Download -> Instructions”.

Documentnaam: TachoReader Basic - tutorial (pdf).

4.3.2. TachoReader Combo Plus

TR Combo Plus manual containing a description of the configuration, procedure of data download
from tachograph and driver card is supplied in the electronic form in the device memory.

The current manual is available (for download) on our website: "https://tachoscancontrol.com/en/"
in the: "Download -> Instructions".

Document name: TachoReader Combo Manual (pdf).

4.4. Open from a file

To open, from a file, the scanned record sheet images or source files from the driver card or the
digital tachograph readings, you can proceed in the following ways:

e click on the: (] icon located in the TachoScan tab in the toolbar;
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e press the combination of ' keys;

e from the Data main menu select Get -> Open from a file.

When you select this option, the normal file selection window appears. Please select the file
containing the desired record sheet (bmp format) or source file that contains the data retrieved from the

8]
driver card or the digital tachograph (list of formats is specified below), and then click =

Do not use this option to edit the record sheets which are already stored in the current control.

The next step depends on the type of file:

Record sheets (bmp)

The program opens "Record sheet view/ edit window" - each additional record sheet is opened in a
new tab.

Digital data (ddd, dtc, dtg, esm, c1b, v1b, tgd)

The program also opens files with digital data archived to formats: ZIP, 7z and ARZ.

Subsequently, data analysis may proceed in two ways :
e Correct reading of data from the driver card/ tachographls'}
e Corrupt reading of data from the driver card/ tachographlso}
e Corrupt reading of data from the tachograph.

If you have downloaded the data from a driver card that is registered as canceled, the appropriate information that
such card was detected is displayed.

4.5. Correct reading of data from the driver card/ tachograph

If the downloaded data are correct, the new driver and vehicle are automatically saved in the
database.

1. Reading data from the driver card:
e All new cars are saved as inactive;

e If in the downloaded reading the program finds a driver that is stored in the database with the
status inactive, it will change their status to active;

e If in the downloaded reading the program finds a similar driver, it opens a window for
selecting/saving a new driver.
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2. Reading data from the tachograph:
e All new drivers are saved as inactive;

e If in the downloaded reading the program finds a vehicle that is stored in the database with the
status inactive, it will change its status to active;

e If in the downloaded reading the program finds a similar vehicle, it opens a window for
selecting/saving a new vehicle.

Then Data summary window appears, consisting of two tabs:

1. Basic data - it contains, among others, card/ tachograph identification data, data on the last
control (driver card) and the date of the previous reading;
In the Number of days since previous download line, the following information is provided:

e o0 number of "calendar days";

e 0 number of "days of recorded activity" - depending on the: Count only days with the
checked activities as the days of recorded activity: option selected ("Settings -> Analysis
settings" menu, "Analysis" tab)

2. Certificates - Analysis of the sections read
e for special files (S files), the Events and faults and Technical data rows are not displayed;

e in the absence of a digital signature, the following annotation is displayed: validdigital
signature not required.
Clicking on:

Print - opens a digital signature print preview window;

cl . . .
== the program closes the window and goes to the preview of a day from the driver

card or the preview of the day from the tachoqraphm.

The additional downloaded data is stored in a binary file in Digital subdirectory of the current control directory.
They can be opened from there and re-analyzed at any time by selecting "Data -> Get -> Open from a file" from

the menu or by clicking on the icon.

If the option Show lack of driver's records notification after new data has been read is enabled
in the program settings and, in the controlled period, the program finds no records, the following
window is displayed:

TachoScan 6.6 Control

o Periods without records were found.
Show Missing data of the driver report?
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o = - the report is skipped - the program proceeds to the next stage of analysis;

Report on missing driver data can be generated during the control using the "Reports -> Lack of driver's
records| 53",

4.6. Corrupt reading of data from the driver card/ tachograph

If the software detects a corrupt reading or invalid certificate, the following window will be
displayed:

TachoScan 5.0

Program discovered errors in the recent reading.

! The data was partly or entirely damaged.
Please repeat reading - if the error reoccurs please contact the
manufacturer of reading device or the manufacturer of
tachograph
Do you want to save the part of the data that was read
succesfully?

Yes - properly read data is saved to the database - a further step is carried out in the same

manner as for a correct reading, except for:
e in the read summary window, reading/file will be displayed in red;
> in the Certificates tab the places where the program detected irregularities will be indicated.

No - downloading data will be canceled.

4.7. Import of data from tachograph to the card

Data

This mechanism makes it possible to fill the empty days, in which the driver does not have any
records of activities from the digital tachograph. You can import tasks assigned to any driver,
activities not assigned to any of the drivers and activities from a given vehicle.

If the driver card is read later, the imported days are removed and replaced by the data read from the card.

Data import mechanism can be run in several ways:
e from the "Data" menu select: Import of data from tachograph to the card;

o=
e "click" the = button on the "toolbar";
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e use the "shortcut" l—‘ + l—-

When you select one of the commands above, import window appears and should be filled in
as necessary:

¢ Driver - to which the data will be imported;
e Period - of the imported data;
¢ Hours range - whether to import all data or only for a certain range of hours;

e activities assigned to the driver - select the driver from whom data will be imported, if
the driver drove the vehicle using the driver card, but has not made it available during the
control;

or

e activities not assigned to any driver - select the vehicle from which data not assigned to
any driver will be imported, if the driver drove the vehicle without a card;

or

¢ all activities from the specific vehicle - select a vehicle from which all data will be

imported (whether they are assigned to other drivers or not), if the driver drove a vehicle
without a card, using other cards, etc.

@ |mport of data from tachograph to the card X
Data  Place entries

Driver
Kowalski Jan ~

Period from il

18-02-2022 [E~ 13-03-2022 [E~

Hours range
{applies to each of the imported days)

@ al

() From 00:00 % Tl 00:00 3

(D) activities assigned to the driver
Kowalski Jan

(O activities not assigned to any driver
Vehide
(®) all activities from the spedific vehide

Vehide |Test 123 ~

Import Close

Days imported from tachograph are marked in the "List of discs/days from card" window ("Data -> Driver
card and record sheet data" menu) as Digital tachograph, while in "viewedit day on the driver card window"
above the driver's daily chart, TC symbol is displayed.

Place entries
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Allows to supplement countries on the driver card with entries from the digital tachograph, in
the case of controls established in TachoScan Control version older than 4.0.9. For this purpose:

,_
O

1. Select & the driver/drivers
2. Choose the period

3. Click . meort

Imported country entries are marked in the "previewedit the day from the driver card window" with a green
line.

From version 4.0.9, when the complete set of data - from the driver card and tachograph - is
opened, the missing country entries from the tachograph are automatically imported to the
card.

5. Preview window of data from the digital tachograph

The window is divided into the following tabs:

5.1. General and technical data

The tab is divided into several parts:
¢ Vehicle data;

¢ Range of stored days - two dates are visible in this part. The first date is the first day with
tachograph actions saved in the database, the second date is the last day with tachograph
actions saved in the database;

¢ Digital tachograph data/Smart tachograph data - this section includes tachograph data;
> O highlight with the mouse to see additional information;
» for smart tachograph, the "Registration nation" row remains empty

¢ Pairing sensors - this section includes data on the motion sensors;
> O highlight with the mouse to see additional information;

> in the Sensor first pairing date field, you can choose a date form the list, which results in
changing the data in the two remaining fields;

¢ Identification of the coupled GNSS facility - this section includes data of identification the
GNSS facility;

¢ Calibration data - depending on the selected calibration date, this parts presents data for the
workshop which performed the calibration and the calibration itself;

e Seals - this section includes information on the way of Mounting and Identification numbers
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of the used seals. There may be up to 5 seals;

> 0. highlight with the mouse to see additional information;

e Analysis of the constant of recording equipment (k) and the effective circumference of
wheel tyres (I) -comparing and calculating the difference of "k" and "I" constants for the
selected calibration (Calibration data -> Select calibration) against the previous one;

» Velocity - on the basis of the difference between "k" and "I" constants (see above) the speed
values for the selected calibration are compared with the previous calibration.

v There are warnings - if this text is displayed in the bottom of the window, it means that the
program has detected irregularities associated with the use of the tachograph in the open readout
- left-click on this text to display a list of detected irregularities ("Manipulation warnings" tab of

"Infringements and manipulations|sN" generation window).

The analysis is based on the settings in the Analysis settings window, "Warnings" tab.

Technical data in red - anomaly detected.

Type of detected irregularities in this tab (depending on settings):

- change in the vehicle identification number (VIN);

- change in the tire size for calibration;

- change in the characteristic coefficient of the vehicle (w) without changing the effective
circumference of tire (1);

- a significant change (over 3%) of the characteristic coefficient of the vehicle (w);

- a significant change (over 3%) of the recording equipment constant (k),;

- incorrect authorized speed in calibration;

- period of 2 years from the last calibration exceeded;

- a high number of calibrations (more than two, except for the calibration carried out on the same
day) during two years;

- date of the first pairing is different from the date of the first calibration-activation.

REPOTt | button - opens print preview of general information and technical data.

5.2. Activities on a specific day
This tab presents a list of all days saved on the tachograph card for the selected range of dates.
Each day can contain the following data:
e date and meter status at the end of the day;
e areas visited (the GNSS country is filled in only if read from a smart tachograph);

> & moves you to the map view with selected GNSS location points (only for smart tachograph
reading);

e detailed information on card insertion and removal by the driver and the assistant;

e actions performed on the given day by the driver and the assistant;

> the following options are available, in addition to the option of removing the selection, in the
drop-down menu after clicking the RMB on the daily chart:
= Copy all activities to driver's data;
= Copy marked activities to driver's data;
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After selecting one of the above options, the program opens a window where the driver is selected.

e list of actions with card insertions and removals for the driver and the assistant;

e list of actions from the card or the chart, if at least one card or chart is in the database for the

given day.
If it is a card, you can open "View/ edit a day from a driver card window" by clicking [Edit];

The option: current vehicle only is selected by default. If the given driver moved in the given day between
vehicles and data from other vehicles was downloaded into the database (driver card download, saving of the
tachograph chart) then MARKING this option will cause that events for all vehicles driven by him will be
displayed.

e Printout (24h) - a simulation of a printout from the tachograph;
e Speed chart - when this option is selected, below the activities chart an interdependent speed
chart is displayed;

The chart is displayed if speed data were collected for a given vehicle.
Dotted line indicates the authorized speed.

The program downloads and stores in the database the speed if Save detailed speed from digital tachograph
option is selected in the program settings window.

Digital tachograph records in its memory speed over the last 24 hours of driving.

Report

Button: - opens a print preview of the day from the tachograph.

Selecting an area

Select an area by placing two vertical brown lines on the chart (fig. ci-dessous). In the Selection tab
(below the charts), in the Selected area field, depending on the selected chart (Driver (slot 1), Co-driver
(slot 2), Driver card), you can read the sum of the events from the selected area. These lines are placed
by single-clicking the left mouse button in the selected place.

Sum of kilometers: 1428
Average speed: 78,5

Fig. Selecting the area.

If the selection includes a driving event, the program will display a tooltip with the total mileage and average speed
(item 1 - fig. ci-dessus).
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Selection can be removed by right-clicking on the chart and selecting the menu option: Remove
selection line or Remove all selection lines (fig. ci-dessous).

* Remaove selection line
Remove all selection lines

v Bind the selection line to events' edges

Copy all activities to driver's data

Copy marked activities to driver's data

Fig. Removing the selection.

In the drop-down menu, there is the Bind the selection line to events' edges option (fig. ci-dessus) - if line is
dragged near the beginning or end of an activity it allows to snap it automatically to the beginning or end of the
activity, respectively.

5.3. Events and faults

This tab contains a general list of not permitted actions related with the tachograph or the card or
other problems with the device, as well as instances of exceeding permitted speed downloaded from
the tachograph.

Button; | =Port opens the preview window for the events and failures printout - the report is

expanded in relation to the view by maximum speed data, average speed data and other driver data,
whose driver card was in the tachograph at the moment of the defect, event or failure.

5.4. Activities, events and faults in the table

This tab presents data for events, failures, exceeding the speed limit, places visited and card
insertions and removals, all put into one table, which can be sorted in any way (by clicking the header of
the given column, another click causes the order to be reversed) and filtered (filters are located on the
right side of the window).

Button: Printout (>>) - opens the print preview window for speed limit violations from the
tachograph.
Button: | =Pt opens the print preview window for actions, events and failures in the table.

5.5. Card insertions and withdrawals

This tab features a list of driver card insertions and removals, which can be sorted and filtered in any
way. In comparison to the previous tab, the list also has information on the country code and the slot
number, from/to which the card was inserted/removed.

Report

Button: opens the print preview window for card insertion and removal.
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5.6. Company locks and last download

This tab presents a list of company locks applied using the company card on the tachograph. In the
top part of the window, card data is displayed for the card using which the last tachograph data
download was completed.

Report

Button: opens the locks and last download print preview window.

5.7. List of controls

This tab displays all road checks recorded by the tachograph.

In addition, in Drivers on the day of the control column, the drivers who had activities recorded on a
tachograph on the control date are displayed.

Report

Button: - opens a print preview window of the controls displayed in the tab.

5.8. Speed profiles

Available only for data downloaded using special software (TachoReader Combo - option: "Special data from
VDO tachograph (S-file)") from Continental VDO tachographs (version 1.3 or later).

The tab shows the time periods in which a specific speed range of a vehicle was registered.

© TachoScan Control - m} X
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Date from Date to Driver Card 0 8 16 24 32 40 48 56 64 72 Q-IO rsa‘:ve;:s
08-07-2013 10:59:27 08-07-2013 10:59:53 00:00:24 - - - - - - - -
08-07-2013 02:00:00 08-07-2013 10:53:27 Kowalski Jan @ BG0000000073635000 08:59:30
07-07-201302:00:00 08-07-201302:00:00 Kowalski Jan © BGE0D00D000TIEISO00  24:00:00
06-07-201302:00:00 07-07-201302:00:00 Kowalski Jan © BE00000000TIEIE000  24:00:00
05-07-201302:00:00 06-07-201302:00:00 Kowalski Jan © BG0000D000TIEIE000  24:00:00 - - - -
04-07-2013 10:25:11 05-07-201302:00:00 Kowalski Jan ©BGO00000007IE35000  15:30:51  00:00:57  00:00:36  0D:0L00  00:00:27  00:01:00 —
04-07-201309:07:47 04-07-2013 10:25:11 01:17:27 - - = - = - = = Rl a:;r;v,.:';,lz:’:ed
04-07-201302:00:00 04-07-2013 09:07:47 Kowalski Jan @ BG0000000073635000 05:00:51 00:06:18 00:03:33 00:04:09 00:04:03 00:05:33 00:07:45 00:16:57 00:15:48 00:
03-07-2013 02:00:00 04-07-2013 02:00:00 Kowalski Jan @ BG0000000073635000 16:17:51 00:27:12 00:24:30 00:25:06 00:30:21 00:35:09 00:49:24 00:44:45 00:57:12 01:
02-07-2013 02:00:00 03-07-2013 02:00:00 Kowalski Jan © BG0000000073635000 24:00:00 - - - - - - - -
01-07-2013 02:00:00 02-07-2013 02:00:00 Kowalski Jan © BG0000000073635000 21:35:03 00:04:06 00:03:36 00:03:57 00:06: 18 00:07:54 00:14:30 00:25:57 00:16:57 00:
30-06-2013 02:00:00 01-07-2013 02:00:00 Kowalski Jan @ BG0000000073635000 20:16:12 00:04:45 00:04:57 00:05:57 00:09:12 00:10:36 00:21:42 00:36:21 00:40:33 o1
29-06-201302:00:00 30-06-201302:00:00 Kowalski Jan ©BGO000000073635000  16:11:15  00:11:48  00:1300  0D:13:54  00:20:30  00:35:33  0L:09:36  01:19:00  0L:10:27 Ol
23-06-201302:00:00 29-06-201302:00:00 Kowalski Jan ©BGO000000073EIS000  16:25:15  00:05:42  O0:0R:18  00:10:27  00:22:18  00:30:27  0L:A%00 011312 OL:11:24 02
27-06-2013 15:33:09  28-06-201302:00:00 Kowalski Jan © BG0000D000TIEIE000  10:21:51 - - - - - - - .
< >
Report

Fig. Speed profiles tab.
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A message informing about the lack of data in the read section of speed profiles is displayed when the speed
registration function has not been configured in the tachograph being read. It is possible to generate a report that
does not contain data from this section.

Report

Button: - opens print preview of speed profiles information presented in this tab.

5.9. RPM profiles

Available only for data downloaded using special software (TachoReader Combo - option: "Special data from
VDO tachograph (S-file)") from Continental VDO tachographs (version 1.3 or later).

The tab shows the time periods in which a specific engine rotational speed range was registered.

@ TachoScan 4.0 Control - O x

Control Data Reports Document Company Vehicles Drivers Settings User Help
Control Retrieve data View data

= S I

Current control Digital tachograph data - ]

Analysis

D) t@h‘o ° O

General and technical data  Activities on a specificday  Events and faults  Activities, events and faults in the table Card insertions and withdrawals Company locks and last download  List of controls  RPMprofies  Speed chart

The results are shown in the column: Time for Time for
Indude in the sum of driving tme revolution ranges from | 03rpm  ~| B "Driving time according to RPM" RPM =0 || 234 < RPM <= 468
o
z Y
Date from Date to Driver Driving time by RPM  Driving time by activities: @ 234

Time for RPM range i
0 < RPM <= 234 in the
e ]

way as pre

< >

= sum of time of revolutions recorded by tachograph in particular profiles is limited to 18 hours, 12 minutes and 15 seconds Report

Fig. "RPM profiles" tab.

The rows in which the driving time according to RPM is higher than the driving time calculated
based on the activity are highlighted in red.

The RPM values in the columns (100, 234, 703, 937, etc.) may differ from the values presented in the above
figure. This depends on the calibration settings of the digital tachograph

A message informing about the lack of data in the read section of RPM profiles is displayed when the RPM
registration function has not been configured in the tachograph being read; It is possible to generate a report that
does not contain data from this section.

Report

Button:

- opens print preview of RPM profiles information presented in this tab.
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5.10. Speed chart

The speed data read are shown on a graph in red, while acceleration is shown on the graph in blue.
Graphs can be freely scaled, moved, printed and saved.

Depending on the option below, the speed chart will be displayed in different colors:

° L Include daylight saving time (Option unchecked):
= Speed according to Regulation 165/2014 - red;
= Detailed speed 4/sec (so-called S-file) - green;

° Include daylight saving time (Option checked):

= Speed according to Regulation 165/2014:
- summer - light red;
- winter - dark red;

= Detailed speed 4/sec (so-called. S-file):
- summer - light green;
- winter - dark green;

Basic information

If the option save detailed speed data from digital tachograph is selected in the program
settings window, the list of speeds will be saved to the database.

You can set the required period that the chart will cover by default.

The blue color represents the acceleration and speed chart. The chart is generated by the
program.

The charts are visible only for the data that have been downloaded from the source file (Open)
or external devices, provided that the option of detailed speed data reading was enabled during
downloading the data from a tachograph.

Tachograph’s memory keeps the speed from the last 24 driving hours, registered with once per
second frequency.

By default, the program shows charts which cover full 24 hours of driving. You can freely scale,
displace, print, save etc. the chart with the tools located above it.

The toolbar comprises the following tools:
o R expands the size of the chart by 10%,

o L. reduces the size of the chart by 10%,
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" zooms the selected area,
P enables displacement of the chart,

—_ - automatically resets the size of the chart to the default values in respect to both

— | - automatically resets the size of the chart to the default value in respect to the
horizontal axis only,

S automatically resets the size of the chart to the default value in respect to the
vertical axis only,

& allows to add a new checkpoint,

® . deletes a chosen checkpoint;

B . possibility to save chart image to a bmp, jpg or png file,
=

- opens a chart print preview window,

'] - Statutory speed data - after expanding the field you
can select additional sections - available only for Continental VDO tachographs, version
1.3 (since 2008), whose data were downloaded using special software (see the following
topic: "Continental VDO since version 1.3 - Additional Sectionsl« 1" for a detailed
description);

4 _ decreases the value in the field described beneath,

'] - a check box to select the time range covered by the displayed

charts:

\4

whole range,

> last 1 minute,

> last 5 minutes,

> last 10 minutes,

> last 15 minutes,

» dates of the individual days covered by the range of the downloaded vehicle speed data,

> increases the value in the field described above.

Goto| -t |{dd-MM-yyyy hh: o . o
| ° | ( yyyy hhmm)] _ If you enter the precise time (date and time) in this

field, the program will center the chart around the time and will broaden the chart to 10-
minute span.
(5 minutes before and 5 minutes after the entered time)

Continental VDO since version 1.3 - Additional Sections

,_
O
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speed data downloaded from Continental VDO tachographs, version 1.3 and later, using

special software (TachoReader Combo - Special data from VDO tachograph (S-file) option) click

on the:

[Speed according to Regulation 3521/85

v] button for additional sections:

for

Despite the fact that this type of tachographs record speed over the previous 168 hours of driving plus
additional sections, during a standard download only statutory speed data (pursuant to Regulation 3821/85)

If the statutory speed (Regulation 3821/85) and speed over the previous 168 hours was downloaded into the
program, in the daily activity graphs from the driver card and/or digital tachograph the statutory speed will be
primarily displayed, and in its absence, the speed from the last 168 hours.

the last 24 hours of driving are retrieved.

[Speed from last 168 hours

'] - speed history of the last 168 hours of driving
recorded with a frequency of one second;

|Detaied speed 4jsec - type 1 v Last three records (high resolution - frequency: four

values /second) of two-minute speed periods, in which there was an unnatural speed
change in a short period of time;

[Demiled speed 4fsec - type 2

v] - Last three records (high resolution - frequency: four
values/second) of two-minute speed periods, in which there was a sudden, high change
in speed;

Additional options

Current cantrol \/ Digital tachograph data oY
General and technical data  Activities on a specific day  Events and faults  Activities, events and faults in the table  Card inserfigns and withdrawals  Company locks and last dawnload  List of controls  RPM profiles  Speed chart
& a 418 & RGO B S| |sped sccordndHequation 1652014 | | 267021 v ot & Jiaamryyyy b B
v v ¥ ¥
Speed chart [lan/h] Acceleration chart x 0, 1[m/s*2] [ Show values on the chart Show table Show checkpoints [(IMieage chart
e Vehicle speed and acceleration chart
o) ¥ L2 9 -] 9 Date velocity km/h]
24,37 km J ¥ \Ij mnm lJo-2usl 13012000 a3 P
O 24-06-2021 12:55:54. 24.06-2021 13:15:29 L 2
0 - — ST 24-06-2021 13:15:02 50
5 Min_17 by 24-06-2021 13:15:03 47
7 WMax: 93 kmin 24.05-2021 13:15:04 %
BS AV T4HT0 kmih 24-06-2021 13:15:05 45
60 24052021 13:15:06 “
55 24-06-2021 13:15:07 41
g 0 24-06-2021 13:15:08 2
£ 24052021 13:15:09 41
s W 24052021 13:15:10 “
E 24-06-2021 13:15:11 39
= 24-06-2021 13:15:12 38
£ ® 24.06-2021 13:15:15 E
e 24-06-2021 13:15:16 £
20 24-06-2021 13:15:17 0
15 24-06-2021 13:15:18 41
10 24-06-2021 13:15:19 a3
5 24.05-2021 13:15:20 £
0 24052021 13:15:21 45
5 240652021 13:15:22 a7
o " 24-06-2021 13:15:23 ®
¥ s 24-06-2021 13:15:25 £
0 24062021 13:15:26 “®
B 24-05-2021 13:15:27 50
24082021 24082021 24062021 2408201 2408201 2406200 20.08-2021 24082021 24082021
1210:00 1220:00 123000 12:40:00 rlgsn 13:00:00 1310:00 13:20:00 13:30:00
Report

Fig. The acceleration and speed chart window.

1. Show values on the chart - displays numerical values directly on the chart.

2. Show table - next to the speed chart, the program displays the speed in the form of a table

7
LO
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(see: blue background in the above figure).

e when hovering the mouse over a point on the speed graph, the value in the table
corresponding to this point will be marked;

3. Show checkpoints - the program will show checkpoints that have been already added and it
will also allow to add new ones:

¢ in order to add a new checkpoint, click & and then on a chosen place on a speed chart;
¢ information displayed between checkpoints:
» traveled kilometers;
date and time;
current speed;
current acceleration/slowing down;
minimal speed;
maximal speed;
> average speed.

YV V V V V

4. Mileage chart - the program will display the number of traveled kilometers on the X-axis of
the chart and the 0 km/h speed will not be included on the chart;

o if the option is enabled, the options Speed chart and Acceleration chart will be
automatically disabled.

5. Authorized speed [km/h] - presented in the form of a line.
6. Lower limit of the chart - possibility of editing.
7. Upper limit of the chart - possibility of editing.

Fig. 2 shows two enlarged charts. You can precisely define acceleration or speed for a given
point in the chart. In order to do so, point out the required position with the mouse — the program
will display a box with the information pertaining to the position (fig. ci-dessous).

,_
O

51



Y/ 4

Preview window of data from the digital tachograph INELO

/4

Speed graph [km/h] acceleration araph x 0, 1[m/fs"2] [T show values on the graph

Vehicle speed and acceleration chart WS

LI S I S B L L S
B
£
B T | | E T
=
=
E ----------------------------------------------------------------------------------
= H Acceleration graph x0,1[m/s"2]
sl ] 11 IO IO U 1 0 1| = A Time: 27-01-2015 06:54:11 :
; m/s"2:1,37 ;
0 E A :\_[Ilil ”lIiJ” .
E-h REEEEEEEEEEEEEE o R R EREEEE R R | b [ERREEEE R R | EEEEE LRl R
T/ P A PR SIS
IR I O | S S N SO S
T T T T
27-M1-2015 27-M1-2015 27-M-2015 27-M-2015 27-11-2015
06:53:30 06:54:00 06:54:30 06:55:00 Time 06:55:30

Fig. Enlarged speed and acceleration charts.

The Speed and Acceleration Report

There is a button to the window bottom right: REPO | that can be used to save all values

recorded in the value diagram in the xls or csv file. The report will show as the summary:

Saving chart data into an "xIs" file is possible on the computer with MS Excel installed.

e for speeds: maximum speed, average speed both in [km/h] and in [m/s],
e for acceleration: Max acceleration and Max deceleration,
e summary distance.

Before saving the file, the application will display the window of period length selection (fig.
ci-dessous) — the period read from the current diagram view will be inserted by default.
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Period

From Till
02-12-2006 ~ 0L00 5 04-12-2006 ~ 00:00 5
Save to xls ] ’ Save to csv ] ’ Cancel

Data is saved to a sheet with a predision of 1 second. The sheet
can contain 65500 rows at the most, Itis recommended to
specify a short range.

Fig. Preparation of the report.

6. Data verification

The next step after recording sheets/ days from the driver card or reading data from digital
tachographs is data verification and analysis of the drivers' tasks against the standards of driving time,
breaks and rest periods in accordance with the relevant legal provisions.

"Lack of driver's records[ss " report displays the periods in which there are no records of record
sheet/ day from the driver card.

In the Infringements and manipulations|s: 1" report, the program offers the ability to automatically
generate the places where there is a suspicion of tampering, as well as tools for indirect analysis of the
accuracy of stored data.

"Compare driving time and distance on the mapl|~Y allows you to check whether the distance
travelled by the driver (or travel time) corresponds to the number of kilometres on the map.

The last topic: "Presentation of infringements[7 1" contains the tools which allow you to show the
places where the infringements occurred and understand their reasons.

6.1. Lack of driver's records

The report Lack of driver's records displays the start and end time and duration of periods during
which the driver activities are not stored in the program activity.

How to create a report

1. In the report generation window
¢ select driver/vehicle or check: All drivers/all vehicles.
e select "Period”, from which data will be displayed;
e possibly for: Show lacks of data option, change the time value;

Options

53



Data verification INE

/4

Show lacks of data
longer than - lacks of data that last longer than time set in this option will be displayed
on the report;

shorter than - lacks of data that last shorter than time set in this option will be displayed
on the report.

Show manual rests

longer than — on the report, the manual entries lasting longer than the time set for this
option will be displayed;

shorter than — on the report, the manual entries lasting shorter than the time set for this
option will be displayed;

Only active for the driver.

To view the report, use the toolbar buttons (see: Generating reports @bl)

6.2. Infringements and manipulations

Report based on collected data generates a list of infringements and interference warnings. The
report is generated for all drivers under the active check. Thanks to the relevant mechanisms it is
possible to quickly move from the infringement to the record sheet/ driver card day on which an

infringement took place. For each violation, you can view and print the ready infringement template
report.

In the final part of the report the Groups of infringements against Regulation (EC) No 561/2006
is presented.

How to create a report

1. Open the report ("Reports” menu).
2. Analysis settings window is displayed, which should include:
e the analyzed period:

> All infringements and warnings — the software analyzes the period between the first and
the last step stored in the database for the specific control;

» period — allows setting any analysis period - by default, the software sets a controlled

period. For a roadside check — unless the to date is checked - the period beyond the

Ay 54
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check date will be analyzed.
e Use activities time tolerance:

Option checked — tolerances of driving times, rest periods and breaks set in the
settings window, under: "Tolerance" tab will be taken into account during the analysis

of the infringements;

[ Option unchecked — these tolerances are not taken into account in the analysis of
infringements;

o All drivers or Selected drivers - the program generates infringements for all drivers or for
the drivers who have been chosen from the list available after clicking

% List of drivers (0)

G te . . o .
e - press this button, the program will proceed to analyze infringements in
the pre-selected period of time - before you click, review the settings described below;

Settings " . . R
. - opens "Analysis settings" window;

T ad d : i
Vanee - click to expand the advanced settings panel.

Attach notes on violations - allows to attach notes that have been added to specific

infringements

Attach control notes - allows to attach general notes from the infringement tabs
Define periods

Button:

Allows to set any dates in which the analysis is to be carried out in the Driver's average
weekly working time report - detailed report that is generated when you click on the button.

Defining periods is necessary for analyzing infringements of weekly working time.

If no periods are defined, generated infringements will not take into account weekly working time
infringements

Button: Detailed report

Opens, for the selected driver(s), Driver's average weekly working time report - detailed
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with specified periods (set using the Define periods button) and weeks, including:

Driver, Period, Week, Weeks count, Driving time, Other work time , Actual working time of the
driver and Norm. In the summary - the sum of weeks, the sum of individual driving and work
periods, and Average weekly working time calculated during the period. If Average weekly
working time is exceeded, it is displayed in red.

Analysis according to

Select whether the data should be analyzed according to: AETR (2010) or Reg. 561.

Report on the basis of data from:

e cards / discs - control of driver's card data and tacho disks;

¢ tachograph - control of vehicle data (mass memory data) — after choosing this option
the frame shown next becomes active:

Data from digital tachograph:

Select the type of analyzed events:
¢ activities with this driver's card inserted - only activities recorded in the tachograph
with driver card inserted;
e all activities from slot 1 - all activities recorded in slot No 1 of the tachograph are
verified, regardless of whether the driver's card was inserted or not;
e all activities from slot 2 - all activities recorded in slot No 2 of the tachograph are
verified, regardless of whether the driver's card was inserted or not;

do not consider lack of data in the beginning of the period as a rest

Option checked

¥

%L—%

4

00:00 00:00
q“ Start of the q
analysis *
o

Stopover,

a stopover, however it is

Lack of data, N Program treats the length as
b
' NOT CONSIDERED to be a rest

Card removed
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[ Option unchecked

Start of the
analysis

Lack of data, I Program treats
Stopover, the length
Card removed as a rest

analyse weekly rest starting from complete weeks (from Monday till Sunday)

the option is accessible only if the preceding one has been checked.

Option checked

Start of the
analysis

An incomplete week Weekly rest analysis
IS NOT SUBJECT starting from
TO ANALYSIS the beginning
of the complete week

Lack of data,
Stopover,
Card removed

O Option unchecked

Start of the
analysis

Analysis of weekly rests from

Lack of dats, the beginning of the analysed period

Stopover,
Card removed
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Compare activities

The tab is only visible for control on the premises option (edit inspection window - "Control" -> "Edit current
control parameters" menu).

Depending on the settings, the tab lists the differences between the tachograph data and the
data downloaded from the driver card. In the comparison, you can also view the data as recorded
by the tachograph when the card was removed. The analysis is performed during the report
generation period.

Activity List

1. Like above, the activity list is generated by clicking on the: Generate button.

If the program detects:
o Activities recorded in the card that are not in any tachograph;
o Activities recorded in the tachograph that are not in any card;

Compare activities tab title will be bolded and will change color into red
(options available in the analysis settings: "Settings" -> "Analysis settings" menu, "Analysis"
tab).

2. Filtering results - above the table there are checkboxes for the driver, the vehicle, and the
"missing” type which allow to filter the analysis results.

3. From any entry in the list you can go to visualize the day with the "missing" items ("day
from the driver card" or "day from the tachoqraphrgbl"). Double-click the left mouse button
on the selected line or select the line and select Edit the day from the pull-down menu, or

1
click on the button: ;

4. Activity Verification - To make work easier, each item in the list can be labeled as Verified -
> Yes / No (first column) - right click on the selected line and select Verified from the
drop-down menu;

Actions All verified and All unverified are available in the drop-down menu.

Printing

Print the list of activity differences . . . . . .
- opens a list print preview window of all items in the

list.

,_
O
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Infringements

Infringement list, edition, options

. Generate o :
As a result of pressing the =neEre button, if infringements have occurred in the

selected period of time, their list will be displayed in Infringements tab with detailed data on
each of them.

Danish version of the program

o the information about percentage of exceeding the standard will be displayed on the descriptions of
infringements;

e Max Rast / Summen af pauser column: depending on the infringement, the following will be
displayed:

e maximum resting time - in the case of too short daily resting time;

o the total time of breaks lasting at least 10 minutes - in the case of exceeding the continuous driving time.

If the program detected irregularities associated with the use of the tachograph or the driver card, the
text under Manipulation warnings will be displayed in bold and change the color to red (Description of
the tab in the following topic.)

1. Results filtering - above the infringement table, there are driver, vehicle and infringement
type and severity selection boxes that allow to filter data in the list of infringements.

2. Approval of the infringements - by default, all infringements detected by the program are
approved. Status of the infringements can be changed using the Approved, All approved
and All not approved commands in the drop-down menu (right-click on any item in the
list of infringements).

Unapproved infringements will have a "No" indication in the Infringement column.

Approved/unapproved infringements can be filtered using the Show approved infringements only
option below the list of infringements.

3. The most serious offenses are displayed in red, bold text;

e the most serious (MSI) and other violations (VSI, SI, MI) can be displayed separately
using filters (see item 1).

Regulation 1071/2009, Annex IV

Most serious infringements for the purposes of Article 6(2)(a)
1.

59




Data verification

INE
/4

a) Exceeding the maximum 6-day or fortnightly driving time limits by margins of 25% or more.
b) Exceeding, during a daily working period, the maximum daily driving time limit by a margin of 50% or
more without taking a break or without an uninterrupted rest period of at least 4,5 hours.

4. Under the infringement list, the overview of the infringement number according to the level
of seriousness is visible. The overview includes only approved infringements.

5. Show approved infringements only - displays only items in the list with Approved status
in the Infringements column

6. On the basis of any violation shown on the list one can proceed to a day visualization when
the said violation was caused (see: Days from card or Discs). In order to do this click the
given violation with the mouse right button and choose the option: Edit the day. 1. It is

i
also possible . to go to the driver's Daily chart window using |—|
-

~

- opens "Weekly chart[7 ",
M_
—| - opens "Monthly chart/ 1"

oo

If you want to add a description to the selected infringement, click CTRL+ E.

Printing

1. [& Report prevew - when you press this button and select the language of the

report, the report preview window displays.

Depending on the option selected: Show not approved infringements in the report (striked out) in
the preview, unapproved infringements will not be displayed or will be shown as crossed out.

Notes to an unapproved infringement will not be printed as crossed out.

Danish version of the program

e the information about percentage of exceeding the standard will be displayed on the descriptions of
infringements.

@3 Conirol report - by clicking, the report is displayed: "Control report/7 1

based on the settings selected in the window.
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Manipulation warnings

List of manipulation warnings

1. Just as the list of infringements, the list of interference warnings is generated when you

Generate : " . :
press the button: s . If the program detects irregularities associated with the

use of the tachograph or the driver card, the text under Manipulation warnings will be
displayed in bold and change the color to red.

2. Results filtering - above the interference warnings table, there are driver, vehicle and
warning type selection boxes that allow to filter data in the list of interference warnings.

3. On the basis of any warnings shown in the list of interference warnings you can go to
visualize the day on which there was a warning (record sheet or driver card day). To do this,
click RMB on the desired warning and select Edit the day. You can also select the specific

. . . Edit the d
warning and click on the following button: e ay

4. For each of the selected warnings at the bottom of the tab, an instruction for checks that
should be performed to verify the warning will be displayed.

Printing

Print selected warnin . . .
& d - opens a print preview window for the selected

warning along with the description.
[& Printist of warrings - opens the print preview window for the list of all
warnings found.

Annotation

Annotations can be entered for the entire inspection in general or specifically for each item in
the lists of infringements, manipulation warnings and activity comparisons.

Inspection annotations:

Available in the Infringements tab only.

Inspection annotations

e add/edit annotations - click on the , button located below the

infringements list;

-
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. . Inspection annotations
e delete annotation - click on the =P button, then clear the contents of

the window and click oK ;

Detailed annotations:

e add / edit annotations - right-click on the selected line and choose Add/edit annotation
from the drop-down menu;

e delete annotations - in the drop-down menu, select: Delete annotation;

Settings made in this window are stored for that control.

In the absence of data from the tachograph and if the limit of country entries on the driver card is used up, the
period beyond the limit is not taken into account when generating lack of the start/end country entry infringements

Example

Let's start a control of our driver, Jan.

From the Reports menu choose Infringements and manipulations.

Control  Data [Reporls Document Company Vehicles Drivers  Settings  User  Help
Control Control report View data Analysis
=l =] Infringements and manipulations a7 =] f f 7 M —mt 1 #"km ] 0
EE @ Drivers' infringements in general Q E m — '.ll '.ll ? §. |—II-| o @‘
{ Start Weekly chart
Monthly chart
Curren Compare driving time and distance ap
I R Events and faults from digital cards — neioo s ]
Sl
You can also use the: icon.
In the infringements generation window:
e check: All infringements and warnings;
e check: Use activities time tolerance;
. Settings
e click the: button;
g g : : . Default
» in the analysis settings window, click on the: button;

Generate

Click:
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<o M T (el

LControl  Data  Reports  Document  Company  Vehicles Drivers  Settings  User  Help
Control Retrieve data View data Analysis

HAEEEEORGREIET T ERE
Start Infringements and manipulatio... .

Report

@ All infringements and warnings
P Generate Use activities time tolerance W Advanced
() Period from  13-11-2006 Til 03-12-2006

_,uflnh' g ts (36)\“' ip ion warnings (19)\

[AII drivers v] [.l\ll wehicles v] [AII infringements v] [NI infringements

Mo Apprc Driver Fegno Date from Date to baxres Morm  Remarks
23 Yes Kowalski Jan, PL 18009101353200W51 7X7X7 27-11-2006, 07:; 28-11-2006, 17 10:00 [6.1] Daily driving time too long by 06:55
P ut & b
25 Yes  KowalskiJan, PL1800910135320000  WwWS| 75747 27-11-2008, 07:20 27-11-2006, 18:21 10:51 0430 [7] Continuous diiving time too long by 08:27

26 Yes MowakJozel PLIT7I0523107510000  WSI 7<7<7  27-11-2006, 18:25 28-11-2006. 07:03 1233 04:30 (7] Continuous driving time: too long by 0308

27 Yes  KowalskiJan, PL 1800910135320000 28-11-2008, 07:03 28-11-2006, 0355 0252 0300 [8.2) Daily resting time too short by 05:08

28 Yes  Nowak Jdzef, PL 1790523107510000 28-11-2008, 07:03 28-11-2006, 0955 02:52 0800 [8.2] Daily resting time oo shart by 05:08

29 Yes Kowalskilan, PL1800910135320000  'WSI 7<7<F  28-11-2006,11:02 28-11-2006. 17:06 DB:04 04:30  [7) Continuous driving time too long by 01:34

30 Yes Mowak Jozef, PL 17905231075100W51 7X7X7 29-11-2006, 07:101-12-2006, 01:139:52 10:00 [6.1] Daily driving time too long by 29:52

31 Yes  NowakJdzel. PL1790523107510000 25-11-2008. 07:08 (1-12-2006, 09:00 00:00 08:00  [8.2] Daily resting time oo shart by 08:00

32 Yes Mowak Jdzel, PL17905823107510000  WwS| 7<7<F  29-11-2008, 07:08 30-11-2006, 16:01 3253 04:30 7] Continuous diiving time too long by 28:23

33 Yes  KowalskiJan, PL 1800910135320000 29-11-2008, 07:08 01-12-2006, 09:00 0C:00 02:00  [8.2) Daily resting time toa shart by 08:00

34 Yes  Mowak Jozel, PL 1790623107510000 23-11-2006, 07:08 30-11-2006, 0708 24:00 10:00  “working time of at most 10 hours at night time exceeded by 14:00

™
2 most serious infringements (Regulation (EC) No 1071/2009, Annex IV, p. 1) have been detected
[ show approved infringements only
[ @t Report preview ] [ % Control report ] l Edit the day ] [ = Weekly chart ] [ Monthly chart

The program displays a list of infringements and tamper warnings. By default, all
infringements have the status: Approved.

In the following items, examples of analysis of two suspected tampering cases are discussed.

6.2.1. Use multiple driver cards

To show the case, data from the driver card of Radek Masar and data from the vehicle he drove
were retrieved.

Tampering of this type can be detected only on data downloaded from the digital tachograph.

In the Infringements and manipulations window, in Manipulation warnings tab, the suspected
tampering is represented as follows ("Use multiple driver cards" filter is applied):
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Control  Data Reports Document Company Vehicles Drivers  Settings User Help
Control Retrieve data View data Analysis
g

B eS=8lE S skl Es 0 @.
Start Infringements and manipulatio.. a

R_Eport

:?: :::;ﬁd:g::eni:;:g;:gs T 505012 Use activities time tolerance i Settings ] [ % Advanced ]
/Infringements _{ Manipulation warnings (10)},

[AJI drivers V] [NI vehides V] [Use of several driver cards '] [Wamings from tachograph and card v]

Verified Date from Date to Vehide Driver/workshop Card Description -
CZ 0000000011111000, CZ 0000000022223000 [The driver has been using multiple cards: CZ 0000000011111000, CZ 0000000022222000

<= r

Warning: The driver has been using multiple cards: CZ 0000000011111000, CZ 0000000022222000. Vehicles: 8A6-9B6 -

Case 1: In the data from the tachograph, use of more than one driver card issued to the same first name and surname is detected and card numbers are similar
(the difference is in one of the last 4 digits).

m

Instruction:

- Using card numbers, check in the Tacholet system for which person were the cards issued.

- Check the driving license numbers in the TachoMNet system when issuing driver cards.

- Check when were both used driver cards issued or if the driver cards were used interchangeably.

- Check if the card with a higher number (e.g. ... 0110) was used earlier than the card with a lower number (e.g. ... 0010). Such a situation is incorrect.

Doubts are raised. if:

- Issuing the replacement card is not a normal procedure and requires verification.

- Using the card with a lower number after using the card with the higher number or using both of them alternatively is illegal. A card with a lower number is

invalid after the new card is issued.

- Check what are the validity periods for driver cards. iy

[ Iﬁ Print selected warning ] [ B, Print list of warnings ] [ Edit the day

In accordance with the instructions provided in the above window (in the example we analyse only
the first case):

1. Using card numbers, check in the TachoNet system for which person were the cards issued.
¢ go into the TachoNet system and perform verification.

2. Check the driving license numbers in the TachoNet system when issuing driver cards.
e verify, as above.

3. Check when were both used driver cards issued or if the driver cards were used interchangeably.
¢ in TachoScan Control, in the same window, double-click on the warning;

e in the next window, the program opens Data from digital tachograph: in Card insertions
and withdrawals tab:
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Control  Data  Reports Decument Company Vehicles Drivers  Settings  User  Help
Control Retrieve data View data
B 85w 8§ S |s8E | ° .
Start Infringements and manipulatio... .y | | Digital tachograph data - 946-... .3
| General and technical data | Activities on a specific day I Events and faults | Activities, events and faults in the table ‘
Card insertions and withdrawals | Company locks and last download | List of controls | Speed chart |
Filter of a date

Date and time Event Driver fowner Previous vehide Odometer  Card Slot Counl ~ | dal
02-03-2010 19:40 Card insertion MasarRadek 9A62574 233932 O CZ0000000011111000 1 EUR
02-03-2010 19:00 Card withdrawal MasarRadek 9AB2974 233932 O CZ0000000011111000 1 EUR From23-07-2006 ~
02-03-2010 17:58 Card insertion MasarRadek 9AG2574 233925 © CZ0000000011111000 1 EUR e
02-03-2010 16:21 Card withdrawal MasarRadek 9AG2574 233925 © CZ0000000011111000 1 EUR T Rsos04 -
02-03-2010 09:51 Card insertion MasarRadek 9462974 233555 © CZ00000OOO11111000 1 EUR
02-03-2010 09:50 Card withdrawal MasarRadek 9AB2974 233556 @ CZ0000000022222000 1 EUR Filter of a driver
01-03-2010 22:21 Card insertion MasarRadek 9AG2974 233479 © CZ0000000022222000 1 EUR [#] everybody
01-03-2010 22:20 Card withdrawal MasarRadek 9AG2974 233479 © CZ0000000011111000 1 EUR l:l
01-03-2010 08:15 Card insertion MasarRadek 9AG2974 232933 © CZ0000000011111000 1 EUR
01-03-2010 08:14 Card withdrawal MasarRadek 9A62574 232933 O CZ0000000022222000 1 EUR
28-02-2010 22:43 Card insertion MasarRadek 9462974 232377 © €7 0000000022222000 1 EUR Filter of a vehide
28-02-2010 22:42 Card withdrawal MasarRadek 9A62574 232377 © CZ0000000011111000 1 EUR all
26-02-2010 23:25 Card insertion MasarRadek 9AB2974 232066 @ CZ0000000011111000 1 EUR l:l
26-02-2010 23:24 Card withdrawal MasarRadek 9A62574 232066 ) CZ0000000022222000 1 EUR
26-02-2010 19:23 Card insertion MasarRadek 9A62574 231777 © CZ0000000022222000 1 EUR
26-02-2010 19:22 Card withdrawal MasarRadek 9AG2574 231777 © CZ0000000011111000 1 EUR Event filter
25-02-2010 13:38 Card insertion MasarRadek 9462974 231134 © CZ0000000011111000 1 EUR @)=
25-02-2010 13:00 Card withdrawal MasarRadek 9462974 231134 @ CZ0000000011111000 1 EUR I:l
17-02-2010 14:44 Card insertion MasarRadek 9462974 227910 @ CZ0000000011111000 1 EUR
17-02-2010 14:43 Card withdrawal MasarRadek 9AG2974 227910 @ CZ0000000022222000 1 EUR
17-02-201009:55 Card insertion MasarRadek 9AG2974 227768 © CZ0000000022222000 1 EUR
17-02-201009:54 Card withdrawsl MasarRadek 9A62574 227768 © CZ0000000011111000 1 EUR
11-02-2010 21:09 Card insertion MasarRadek 9A62574 226051 @ CZ0000000011111000 1 EUR
11-02-2010 21:08 Card withdrawsl MasarRadek 9A62574 226051 © CZ0000000022222000 1 EUR L

e card insertions and removals are sorted by date (fig. ci-dessus) - on the basis of the displayed
results you can tell in a simple and fast way that the cards were used interchangeably;

e in the same window, in the Activities on a specific day tab, the program uses the exclamation
marks "!" to display the places where tampering is suspected:
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LControl  Data Reports Document Company Vehicles Drivers  Settings User Help
Control Retrieve data View data Analysis
it | e = km
IS A E IR 0 O
Start Infringements and mampulatlo‘..a Digital tachograph data - 9A6-.. J
‘ Card insertions and withdrawals | Company locks and last download | List of controls | Speed chart |
‘ General and technical data | Activities on a spedific day | Events and faults I Activities, events and faults in the table |
Selectdate o (01032010 =] B [ Prntout(2sn) | Places
Cdometer at beginning of the day 232557 = Driving time  16:33 Select nme OB =
Qdometer at the end of the day 233556 | | Average speed B0 Odometer: 232333
Difference inkm 999 5 / Registration number 9AG-9B6 Country and region: EUR /
EUR
1 2 3 4 1
e W T YT
=1
WW M| Il ;
T T T T T T T T T T T t T T T T U T T T T
1 2 3 4 El B T 8 ] 10 11 12 13 14 15 16 17 18 149 20 21 22 23 o 1
Slot 2:
17:30
1
e, B kB, bk kb B @A BAL B B Rk
T2 H 4 5 & 7 & B o i1 1z i3 14 s & 17 i8 13 W ;2 3 0 1
Selection | Driver (slot 1) I Codriver (slot 2)
Driver [slot 1] Codriver [slot 2]
Selected activity Selected area Selected activity Selected area
Mode: by Time:00:13 © [ o000 Mode: [ Time:01:14 © [o0:00
From:18:52  Till: 19:05 From: 17:29 Till: 18:43
Status: Driver Status: Driver
Card: inserted Card: withdrawn
Driver: MasarRadek Driver:
C€Z 0000000011111000

¢ on the first (upper) data chart from the first slot in the tachograph, after highlighting with the
mouse, data of the inserted driver card can be read (bottom tab:Selection -> Driver (slot 1)).

4. Check if the card with a higher number (e.g. ... 0110) was used earlier than the card with a lower
number (e.g. ...c0010). Such a situation is incorrect.

e in the former case, it was apparent that the cards were used interchangeably, i.e., the condition
was met: a card with a higher number was used earlier than the card with the lower number.

If the TachoNet system confirms that the cards were issued to the same person we have a
clear case of tampering.

6.2.2. Driving without an appropriate card

For the purposes of this example, we retrieved data from the digital tachograph placed in the
vehicle: WSI 7X7X7.

If the control is carried out in the company, retrieving data from a specific driver card depends on
further analysis.

As in the previous example, this type of tampering can be detected only for the data collected from a digital
tachograph.
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In the Infringements and manipulations window, in Manipulation warnings tab, the suspected
tampering is represented as follows ("Driving without an appropriate card" filter is applied):

et L . e

Control  Data  Reports Document Company Vehicles Drivers  Settings  User Help
ContrDI Retrieve data Vlew data Analysis

EEEEESSE - SIS )

Start Digital tachograph data - WSI .. 3 | Infringements and mampulatio...a
Report

@ All infringements and warnings =
o Generate Use activities time tolerance % Advanced
() Period from 28-07-2006 Til 25-08-2014

{Infringements _{ Manipulation warnings (68)\

[NI drivers V] [AJI vehides V] [Driving without a proper card V] [Warnings from tachograph and card -

Verified Date from Date to Vehide Driver fworkshop Card Description Annotation =
“__ Driving without @ proper card for 1h 27min from 22-01-2011 19:05 til 22.01-201120:32 | |

22-01-2011 18:17 22-01-2011 19:03 WSI 7X7X7 Driving without a proper card for Oh 46min from 22-01-2011 18:17 till 22-01-2011 19:03

22-01-2011 16:38 22-01-2011 18:04 WSI FX7X7 Driving without a proper card for 1h 26min from 22-01-2011 16:38 till 22-01-2011 18:04

22-01-2011 15:43 22-01-2011 15:55 WSI 7X7X7 Driving without a proper card for Oh 12min from 22-01-2011 15:43 il 22-01-2011 15:55

22-01-2011 15:08 22-01-2011 15:14 WSI FXTXT Driving without 3 proper card for Oh 6min from 22-01-2011 15:08 till 22-01-2011 15:14

22-01-2011 14:56 22-01-2011 15:04 WSI FXTXT Driving without a proper card for Oh 8min from 22-01-2011 14:56 till 22-01-2011 15:04

22-01-2011 13:59 22-01-2011 14:54 WSI TXTXT Driving without 3 proper card for 0h 55min from 22-01-2011 13:59 till 22-01-2011 14:54

22-01-2011 12:54 22-01-2011 13:50 WSI 7XT7XT7 Driving without 3 proper card for Oh 56min from 22-01-2011 12:54 il 22-01-2011 13:50

Warning: Driving without a proper card for 1h 27min from 22-01-2011 19:05 till 22-01-2011 20:32

Instruction:
- Check if Article 16 of Regulation 3821/85 may be applicable (driving without a driver card inserted, due to poor operation of / lost / stolen driver card,
up to 15 calendar days).

During the analysis of mass storage, it appears that the vehicle was driven without a driver card inserted or was driven using the wrong card. H
- Check if the appropriate printout or manual entries were made.

@. Print selected warning ] [ @ Print list of warnings ] ’ Edit the day

In accordance with the instructions in this window:
1. Check if Article 16 of Regulation 3821/85 may be applicable.
e make verification.
2. Check if the appropriate printout or manual entries were made.
e for each driving event without the right card, we are looking for confirmation in the manual
records.
Subsequently, the control is dependent on manual records shown.

Using TachoScan Control, you can find the driver/drivers who drove the vehicle before and after the
events: Driving without an appropriate card. In our example, let's consider the longest driving event:
Th 27min:

e double-click the mouse on the above warning;

e in the next window, the program opens Data from digital tachograph: in Activities on a
specific day tab:
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‘= TachoScan 2.1 Control

=SSR
Control  Data Reports Document Company Vehicles Drivers  Settings  User Help
Control Retrieve data V\e'w data Ana\y;i;
0
B el wEBE S 88 @ b o o-
| start |/ Infringements and mampu|at|o...¢3\," Digital tachograph data - WsL.. .3'\
[ Card insertions and withdrawals I Company locks and last download | List of controls | Speed chart
General and technical data | Activities on a spedific day Events and faults I Activities, events and faults in the table
Select date [22-01—2011 v] B [ Printout (240) | Places
Odometer at beginning of the day 510756 Driving time  15:06 Select tine [:]

Odometer at the end of the day 511593

Average speed 5O Odometer:
Difference inkm 837 Registration number WS FX7X7 Country and region:
Slot 1:
00:00 0
12 3 4 s e 7 & )
Speed d’ﬁrt .
T T T T T T M‘!
1 2 3 4 5 B
Slot 2:
00:00
I mi t t a t t t 'I_| t t } t t } } Z } } } } t t t E.I t {
1 2 3 4 5 [ 7 B 9 10 11 12 13 14 15 16 17 18 19 0 21 2 3 0 1
Selection | Driver (slot 1) | Codriver (slot 2)
Driver [slot 1] Codiiver [slot 2]
Selected activity Selected area Selected activity
Mode: Time: Mode: Time:
From: Till: From: Till:
Status: Status:
Card: Card:
Driver: Driver:

e exclamation mark "!" indicates the places where tampering is suspected (fig. ci-dessus). In our

example, these are driving events without an appropriate card;

e the chart also shows that the driver card insertion event was recorded in the tachograph,
followed immediately by the regular driving activities (fig. ci-dessous).

e ==
Control  Data Reports Document Company Vehicles Drivers  Settings  User Help
Control Retrieve data View data Ana\y;i;

Baala B E = s e E o ° -
| start |/ Infringements and manipuh-itio...g‘uIr Digital tachograph data - WSL... (3, |
[ Card insertions and withdranals I Company locks and last download I List of controls | Speed chart

General and technical data | Activities on a spedific day Events and faults I Activities, events and faults in the table
Select date -l [22-01—2011 v] B [ Printout (240) | Places
Odometer at beginning of the day 510756 Driving time  15:06 Select tine [:/—i

Odometer at the end of the day 511593 Average speed 55 Ocometer:

Difference inkm 837 Registration number WSI FX7X7 Country and region:

Slot 1: | \_\/
K

- IR

¢ highlight the place of card insertion with the mouse (fig. ci-dessus) and in Selection tab
(located under the graphs) read driver details - in this case, Szczepan God;
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e then, we are looking for a driver who was driving the vehicle before the driving without card
events - scroll the chart back, until the place of driver card removal (fig. ci-dessous) appears;

[ Control Data Reports Document Company Vehicles Drivers Settings User Hep |
Control Retrieve data View data Analysis
B2 8w 8B F S 88l 88 E O O
Start Infringements and manipulatio... .| | Digital tachograph data - WSI... 3 Il
| Card insertions and withdrawals | Company lodks and last download I List of controls I Speed chart |
| General and technical data | Activities on a spedfic day | Events and faults I Activities, events and faults in the table |
Select date [20-01—2011 v] » [ Printout 24 | Places
Odometer at beginning of the day 509670 wing time 15:27 Select time

Odometer at the end of the day 510560 1& speed 58 Odometer: 510031
Difference in km 890 R\/tumher WS 77T Country and region: PL
Slot 1:

as above, highlight the place of card removal and read the driver details from the Selection tab
- itis also Szczepan God;

there is a high probability that the driver drove the vehicle without a card - retrieve data from
his driver card;

re-open the Data from digital tachograph: window, in Activities on a specific day tab -
compare the graph of the activities from the tachograph with the chart for Szczepan God:

Card insertions and withdrawals I Company locks and last download | List of contrals I Speed chart
General and technical data | Activities on a spedific day | Events and faults | Activities, events and faults in the table
Select date -l [2041 1-2011 - ] » [ Printout24) | Places
Odometer at beginning of the day S09670 Driving time  15:27 Select time
Odometer at the end of the day 510560 Average speed B8 Odometer: 510031
Difference in km 890 Registration number WS 7X7K7 Country and region: PL
Slot 1:
22:47 o
-
i 2
50
T T T T T T T T T T T T T T T T T T T T T T T T T 0
1 2 3 4 4 E 7 g 9 10 11 12 13 14 15 16 17 18 19 20 il 22 23 o 1
Slot 2:
0o:17
1 1
I } } } t } } } } } } } } } } } } } T } } } } } |
1 2 3 4 5 [ 7 ] 9 10 11 12 13 14 15 16 17 18 19 20 21 2 3 [1] 1
Comparison to data from driver card or . = X "
disc Select a dnver| God Szczepan lzn current vehicle only Edit
Driver card
17:11
! ! R A
12 3 4 5 [ 7 [ 5 10 11 iz {3 14 iz s 17 g i3 20 2 2 23 0 1
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If Comparison to data from driver card or disc chart is empty, uncheck current vehicle only and select the
appropriate driver.

e already in the first "driving without card" period (fig. ci-dessus) you can see that Szczepan God
has no records besides manually entered stop - in the next days, the situation is similar, until
the place of card insertion;

e if necessary, you can copy the activities from the tachograph to the driver card - the program
offers such a possibility in the "view/ edit day from the driver card" window:
» click on the [Edit] button placed right of current vehicle only option;

S1

» in the Driver's daily chart window, click on , to display the graph from slot no. 1 of the
tachograph, and then uncheck the editing blocked option (fig. ci-dessous);

If the Vehicle field is empty, click on the =¥ jcon and then select the appropriate car.

e
Control Data Reports Dgcument Company Vehicles Drivers Settings User Help
Control Retrieve data View data Analysls
g & ~*km
EIGEE- IS G I P EED °©-
Start Infringements and manipulatio... 3y | Digital tachograph data - W5l .. (3| Driver card God Szczepan )
Driver Driver's daily chart [¥] editing blocked |
GodSzczepan, L [+ || XTI o2 o
Day ™
[) 20012011 B~ [ h h ) ®
yehide 1 H H 4 H & 7 [ ] 10 11 12 13 14 15 16 17 18 15 20 2 2 ) o 1
WSI 7X7XT - Activities in tachograph slot 1 Speed chart [V]
K initial Km final m
508670 510031
& [s1] =
Edit Edit
50
r T T T T T T T T T T T T T T T T T T T T T T T 10 =
1 2 3 4 5 5 7 a 3 LT 1213 14 45 18 17 18 13 2 A 2 23 0 1
List of actvities Overview Selection Infringements
U] List of actviti
B storachuiies From | Til | Tme Mode Team Sot Reg.no Selected activity The hereby analysis was performed for a day.
—| [¥] Overview 05:53 . . Ary infringements have to be verified in the
e el R e gxm || © - 51 et
T rom: il
2 | []selection § ::i: g':; e 'Nh : :E_mn? '01 m Status: Mo remarks - the disc is OK
| Wlinfringements = ® - G d:
3 4 0315 05:01 0146 (2 No 1 WSI A7 108,4 ard:
] 5 0501 08:14 0313 |y MNo 1 WSIAWT 0 ] 00:00 Driver:
6 08:14 11:38 0324 (D Mo 1 WSIX7XT 2086
7 1138 1139 0001 %2 Mo 1 WSIATKT 0 b [75s celected area
8 1138 0L0D 1321 | ME 1 wsImmT o [ 0:00 |
2 [ o000
S| 361k |
~ ra " S
@ There are wamings = Weekly chart ] [ = Team chart ] [ [, Print activities ] [ [ Print pictograms ] [ save

» right-click on the activities from the tachograph graph and select Copy all activities from the
drop down menu (fig. ci-dessous);
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Driver's daily chart

23:56 R4

) ) } t + t } t =|—|§ } ) + t ) t |
1 2 3 4 5 [ 7 -3 9 10 11 12 13 14 15 18 17 bt 19 20 1 pai 3 0 1
Activities in tachograph slot 1 Speed chart [¥]
14:07

000

* Remove selection line
Remnove all selection lines

v Bind the selection line to events' edges S0

T T T T T T T T T T T T T T Copy all activities to driver's data T T T T 0

Copy marked activities to driver's data

o Copy all activities - (graph from the tachograph) - regardless of the selected function copies (overwrites) all
activities from the tachograph onto the driver card;

o Copy selected activities - (graph from the tachograph) - make the selection by left-clicking (area). After
selecting this option activities of the tachograph will be copied to the driver card within the selection;

e Copy events from tachograph - slot 1 - (chart of the driver card) - the option is active only for card
withdrawn periods. It copies all events from slot no. 1 of the tachograph to the driver card. If you turn on the
chart from slot no. 2, Copy events from tachograph - slot 2 option is available.

e after copying activities, go to the: "Infringements and manipulations| s report and generate
violations for Szczepan God again.

6.2.3. Compare driving time and distance on the map

The section is available for the Expert license as GNSS Location. Tolerance and Route analysis panels are
not available.

Opens a Google™ map window, where you can compare the mileage read from the tachograph and
driver card against kilometers from the route designated on the map.

The main objective of the analysis is to verify whether there was any tampering that leave no trace in
the tachograph and on a driver card. It is actually the only tool to verify whether the driver tampered
with the tachograph with a magnet or by reducing the voltage.

For vehicles with digital tachographs, to make a comparison, select:
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Current control §/ Compare driving time and dist... (3}
(1) Routcanatyst O O LOJ1 | 12
Date from o0 [2] % Tolerance 2 Route M7 Farryfran s Mo ey S Tachogoph € brier crd %5
Date to 22-09-2021 | [23:59 (= Distance 3 % Route length (km) 496 (609) o - El
Vehide e - Time [off%  rout tme Gmm) 05:50 (07:49) -
[ 7 = Jonkdping AT
[ Route I Map Satellite @ Toggle view == Gnthurg Borés g VEstegk
c , 1 Vishy
A |SmeuJSC\E, Poland |n'L D 5] gk
Kung8backa
B |GDthenburg, Sweden | Hjarringe Frederlkshavn unglibac YR
+ Add destination Vendsyssel i dskarsh
E3 Vamamo
Show route in the map Aalborg Varlerg
Thisted 2
5 Fallfgberg Vaxja
Options ~ t‘g B
Halistad Kalmar
Avoid O Highways k g
O ol Randers
Holstebro &
Ferries I m
Silkeborg Aarhus Hassleholm Karlskrona
E6 609.23 km Helsingborg Kristianstad
i Horsens
°
Billund  Vejle
5 ) O(:ope%hagen Sthind
E20 684.44 km ] )
I Esbjerg & Depmark Roskidg Malrriés
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(item 1) - fig. ci-dessus) analyzed period of time and vehicle

GNSS points (GNSS places)
(item 4) determine the route on the map

It is possible to select additional options from the drop-down list (item 5).

(item 2) determine the tolerance of variation between indications for time and distance

(item 3) choose a tab with the route on the map (Route) or with the route according to the

The program will display the available routes. By default, the route from the first position in the list

will be displayed on the map. It may be changed by clicking on the selected route (item 6).

e (item 7) driving time and distance read from Google™ map

= the numbers outside the parenthesis - do not include the values from ferry/train

* number in parenthesis - includes the value from ferry/train

e (item 8) the suggested time and number of kilometers traveled by ferry/train read from the
Google™ map (editable)
e (item 9) the suggested route time and length according to the GNSS localizations
= the numbers outside the parenthesis - do not include the values from ferry/train
= number in parenthesis - includes the value from ferry/train
e (item 10) the suggested time and number of kilometers traveled by ferry/train read from the
GNSS localizations (editable
e (item 11) the tachograph data
e (item 12) data from the driver card
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& - opens a "report print preview" window after expanding [~] the options of generating the
report, you can choose a report For Google route or For GNSS points.

To change the course of a route, drag it to the chosen point through which it should run fig. ci-
dessous:

iewice
o

El 5 Warka
[=]

[£<7 %’,m R

| Drag to change route inmim
o

]
ki

Deblin
o

Fig. Changing the route

For vehicles with smart tachographs, use the "Show GNSS location points" option, which will
display the route created based on the location points (after selecting it, select the vehicle and set the
date range). Use additional options to modify the route.

If there are no points, an appropriate message is displayed.

6.3. Presentation of infringements
The following are tools useful in the analysis of infringements:

"Weekly chart[ 71" - represents a seven-day chart of driver activities (data from record sheets/ days
from driver card) or a graph of activities from the digital tachograph. In the chart, you can find all
infringements (see the explanations is in the "Legend” tab). Driving periods for each day and weekly rest
periods are shown in a transparent manner;

"Monthly chart[ 71" - represents a five-week chart of driver activities. The graph clearly shows the
weekly rest periods and 2-week driving period;

"Control reportﬁﬁ" - in the report, Weekly chart is presented with a detailed description of each
week, which can be displayed in several languages. The report can be printed or exported to PDF file.
Control report is a sort of answer to what the infringements result from.

6.3.1. Weekly chart
Weekly chart is a graphic representation of driver's activities in specified weeks.
The chart may be accessed in the following ways:
e From the main Reports menu, select: Weekly chart;

e after pressing the m or - Weekly chart button in the preview windows of the

days from the "driver card" / "record sheet" and in the generation windows for the following
reports: "Control reportmﬁ" and "Infringements and manipulations|s)";
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Designation of the driver's activity is the same as in the "daily chart from the driver card [T,

To activate the report:

e specify driver's name (selected from the list);
or

e Vehicle;

» If in the downloaded reading the program finds activities stored on the first and the second
slot, the following selection options are displayed: Slot 1 and Slot 2;

For vehicles, only events are displayed - the program does not analyze any infringements.

¢ specify "time extent";
e press the button: v,

The following options are available in the weekly chart:

Button: Monthly chart

Opens in a new tab: "Monthly chart[7 Y.

Selected activity

In the Selection tab on the left side of the chart, in Selected event field, the information on
the event pointed to with the mouse (fig. ci-dessous) is displayed.

The time of inserting and removing the driver card will also be visible in the chart, if they were downloaded
from the tachograph card for the given day and for this vehicle.

After placing the cursor on the card insertion and removal symbol in the Selected activity field, an
appropriate bubble text will appear.

17:19 23:52 08:54 @07:42 £15:10 Selected activity
Monday [ L] LS L] L+ ] [ Type: driving
2013-09-23 m 1:34 047 102 111 040

| | | | | | | | I | | |

0 1 2 3 4 5 3 7 § 9 10 11 12 - 16 17 From: 2013-09-23, 11:59

00:04 08:54| |09:22 Q0433 £7:53 1715 X
o 2 | ';5{ Til:  2013-09-23, 13:04
uesday [ L L - )

2013-09-24 5:00.(40), I oag [~ gaz [o| "™ O1h05min

I | | | | | | | | | | | |

0 1 2 3 4 5 3 7 g ] 10 11 1z 14 15 16 17

Fig. Point with the mouse to one of the driver activities on the chart.

Selected area

In the Selection tab, on the left side of the chart, in In the selected area field, a summary of the
selected period is displayed. Click with the mouse two points at the weekly chart. Two lines will
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appear and mark the resp. period of time (item 1 and 2 - fig. ci-dessous).

00:00 2352 5:54 Q07:42 £15:10 Selected area
Monday h Q % O © [ 1105 |
2013-09-23 | . . . IM B ) | | | 1:3a|1 l):l-ﬂ 1:u|2 1:1|1 0:40 -
0 1 H 3 4 5 3 7 ] g 1 dr 43 14 d5 16 47 R
00:04 08:54 B04:35 £7:53 17:15
o 3 "
Tuesday Pt L o ‘I‘S?I Gslt A | o000
2013-09-24 G:00 (4x9) 0:43 047
| | | | | | | | | | | | | h
0 1 H] 3 [l 5 ] T ] ] I 15 16 17
hh 09:18
Wednesday n 00:00
2013-09-25 "
T | 2800

Fig. Marking a part of the weekly chart.

You can grip those lines (marks) with the mouse and move them as you need (item 1 - fig. ci-
dessous). Having set the second mark you can make it jump to another position by clicking another
spot of the chart.

If the selection area is larger than the chart displayed on the screen while selecting, or have other problems,
you can use when selecting an area from the drop-down menu.

Setting the start area - click the PPM to the desired location and drop-down menu, select Set beginning

Settings for the end of the area - click the PPM to the desired location and drop-down menu, select Set
end.

There is the option Bind the selection line to events' edges below the chart. When this option is activated
the placed selection lines will be automatically moved exactly to the end/begin of the neighboring activity
(item 2 - fig. ci-dessous).

F8:54 Bo7:42 £15:10

Fig.3. Move selection line.

Overview and legend

In the third window: Overview, subsequent events from the weekly chart are totaled, for the
driver or the vehicle, respectively as well as OUT and AETR periods.

And in the fourth window Legend is shown.

Visualization of infringements (for driver only)
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In addition to the linear visualization of events, the chart also shows the places where
infringements related to exceeding the driving time, working time or shortening the rest time
occurred.

Only confirmed violations will be displayed in the weekly chart.

The infringements analysis is carried out only for the selected driver.

The place of display is shown in the figure below (fig. ci-dessous).

Infringements related to exceeding the driving

time are shown in the top part of the chart

L
06:00 ©10:00 3x10) E1200 —0——————— 1500 -l
10:45 1:00 1:00 \
| | I | |
0 i 2 7 8 [ 10 11 13 13 14 15 46 dr 15\-|

|
3 4 5 [

Infringements related to reduced rest periods

are presented in the bottom part of the chart

Fig. Place, where the offences detected by the program are displayed.

Description of the other markings on the chart can be found in the Legend tab.

"Days"” Tab

The Days tab shows the sums of four basic events (driving, work, driver's availability, stop) for
each day separately.

View/edit days from the driver card/record sheet on weekly chart

From the weekly chart level it is possible to open the view/edit the day from the driver
card/record sheet (for a driver), or to open the day preview window from the digital tachog raphlsz]
(for a vehicle) - from the weekly chart drop-down menu, choose:

o Edit day

or
e double-click on the chart area for the selected day

The program will open a preview window for the selected day in a new tab.

Additional options
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You can better evaluate particular parts of the chart by enlarging it with: ) (button under the chart). Use

the button — to make the chart smaller. The default size of the chart can be regained with "'i}

Chart printout

Print button, a pull-down

It is possible to print out the chart. After clicking LMB on the
menu will be displayed, with the following options:
¢ Print visible week - displays the print preview for the currently viewed week;
e Print selected weeks - displays the print preview for the currently marked weeks (see
"Selected area" above);

¢ Print entire period - displays print preview for weeks included in the control period;

Options related with printing the chart:

¢ Show legend on the printout - if this option is marked, the legend will be displayed on
the last page of the report;

e Show activities list on the printout - after marking this option, a list of actions included
in the chart will be displayed under the weekly chart, right above the legend;

6.3.2. Monthly chart

-

There are 5 consecutive weeks displayed in the monthly chart which provides easier and faster

analysis of weekly rests, weekly driving time and fortnightly driving time.

The chart may be accessed in the following ways:
e from the main Reports menu, select: Monthly chart;

e after pressing the m or Monthly chart

button in the "weekly chartl 1"

window and the generation windows for the following reports: "Control report/» 1" and

"Infringements and manipulationsm".

To activate the report:
e specify driver's name (selected from the list);
e specify time extent,

e press the button: v ;

The main features of the monthly chart

1. One week displayed in one line.
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2. The whole chart view covers 5 weeks (we can see the whole period of 28 days).

3. An option that enables the display of rest periods only is available:

e you can select the length of rest periods to be shown in the chart (daily and weekly rest
periods are displayed by default);

Display of 24/30 hour periods.
Display of a 6-day period for taking a weekly rest.

Day/weekly rests are drawn differently than in the weekly chart (see the legend).

N o vk

Options/mechanisms taken from the weekly chart:
¢ the option of marking any area (dragging the marking to the event edge);
e displaying the data of a backlit event using the mouse;
e visualization of the offenses;

Chart printout

You can print the chart. When you left-click on the Print

appears with the following options:

button, a drop-down menu

¢ Print actual view - opens currently displayed month printout preview;

e Print selected period - opens currently selected period printout preview (see topic:
"Weekly chart -> Selected areal+ I');

¢ Print entire period - opens printout preview of all the weeks in the controlled range;

Options related to chart printout:

» Show legend on the printout - if this option is checked, then the chart legend will be
appended to the printout;

» Show activities list on the printout - if this option is checked, then all the driver's
activities in the printed period will be listed in the printout (right before the legend).

Switching to the daily chart

1. Right-click on the activity on the selected day.
2. Select Edit the day from the drop-down menu.
OR

1. Double-click on the activity on the selected day
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6.3.3. Control report

This report is helpful in understanding the analysis of driving time, time of daily and weekly rest
periods and to understand and explain any infringements detected by the program. The report can be
called either from the menu: Reports -> Control report as well as from the infringements report
generation window: "Infringements and manipulations/s 1" when you press the button:

’Eg Control report

Report construction

o weekly chart of record sheets activities/ driver card days (key on the last page of the
report);

o weekly and two-week driving time (for the current and the previous week) with comments
on possible cases of exceeding the norms and driving time available next week;

¢ information on weekly rest periods: the time the rest was used and its duration, possible
reduction and compensation, then the number of days between the previous and the
current weekly rest period;

e information on daily rest periods: for each day the maximum time of rest and the time of
daily rest used are shown. In addition, comments on these times are entered, stating the
compliance with Council Regulation (EEC) No 3820/85 or Regulation (EC) No 561. The
division into the days is done according to the provisions of the laws;

e daily driving periods: the length of the cycle (daily driving period), the analysis of daily
driving time and constant driving time, comments on possible exceeding the norms. The
last column shows the penalty amount for the driver and the company according to the
fines for infringements;

¢ on the last page there is the key for the signs used in weekly activities chart.

How to create a report

1. Open the report ("Reports” menu).

2. Inthe report generation window select:
e adriver's surname (chosen from the activated list);
e the period of analysis;
¢ select whether the data should be checked according to, AETR (2010) or Reg. 561;
e Report on the basis of data from::
» cards / discs - control of driver's card data and tacho disks;
> tachograph - control of vehicle data (mass memory data) — after choosing this option the
frame shown next becomes active: Data from digital tachograph: where one can choose

what data are to be analyzed:

= activities with this driver's card inserted — only activities recorded in the tachograph with driver card
inserted;
» all activities from slot 1 — all activities recorded in slot No 1 of the tachograph are verified,
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regardless of whether the driver's card was inserted or not;

= all activities from slot 2 — all activities recorded in slot No 2 of the tachograph are verified,
regardless of whether the driver's card was inserted or not;

Infringements committed outside the period of employment of the driver or outside the scope of control are marked

Options

For a detailed description of other options refer to: "Infringements and manipulations|s ' ->
T Advanced

tab.

show weekly chart on the report

After selecting this option, the so-called weekly chart of driver's driving time will be shown
at the end of each week section,
(markings of symbols on the chart is the same as on the "weekly visualization[71").

Colour

As a result of selecting this option, some elements of the report will be presented in several
basic colors, otherwise it will be presented in shades of gray.

Legend

After selecting this option, a legend for the weekly chart will be presented in the final section
of the report.

Display amount of fines (only in Danish and Romanian language versions)

Option checked — unapproved amount of fines will be shown according to tariffs of
penalties applicable in Denmark/Romania ;

[ Option unchecked — unapproved amount of fines will not be displayed;

Button:ll‘_"

Opens "Weekly chart[+.
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Button: ol

Opens "Monthly chart[ 7.

To view the report, use the toolbar buttons (see: Generating reports @ﬁ)

7. Locking and exporting of control

After approval and printing out is done, or after copying of reports is finished, we may set about
the locking of control. Control locking is necessary for it to be exported.

In order to lock control we press the second icon:

TachoScan displays a window confirming control closing and then a control summary window:

ra Ty
TachoScan 2.1 Cmﬁﬂ‘ e

Control locked 0001-2008-1234-1234

Mumber of updated days: 174 (13-06-2006 - 03-12-2008)
Mumber of infringements found: 40

Ok

Control exporting

Once they are complete and locked, controls may be exported for archiving purposes. With this
purpose in mind, from the Control menu we opt for Export selected controls.

81



Y/ 4
Locking and exporting of control INELO

Control | Data Reports Document Company Vehicles Drivers Settings User Help
Retrieve data View data Analysis

88§ S 8850 b | WS

Mew control

Edit current control parameters

H| O
1]
Edit/view selected contral X m—_l-I] Ml @‘

Delete control

Archives L4

Export selected controls h

Set directories 001-2008-1234-1234 Cargo goods Driving tim

Exit the program 8-04-2008 Registration nation current country Recording
Company Transport CO Type of road Driver
Locked 26-08-2014 Type of tachograph Co-driver

It is also possible to opt for control exporting from the Controls menu window.
By default, the TachoScan software exports selected controls to the directory: "C:\Documents
and Settings\UserName\My documents\Controls\Export".

If we want select another directory for saving exported control, then, we use the Set directories
option from the TachoScan menu.

Control | Data Reports Document Company Vehicles Drivers  Settings  User Help
Retrieve data View data Analysis

MNew control

Edit current control parameters L | |E| || |g| |§| |@| |é| |-?._|l| |Eﬂ;|l| |§| | §!

Edit/view selected control

Y
Ei | OO

Delete control

Archives L4

Export selected controls

Set directories 001-2008-1234-1234 Cargo goods Driving tim

Exit the program Alt+ X §-04-2008 Registration nation current country Recording
Company Transport CO Type of road Driver
Locked 26-08-2014 Type of tachograph Co-driver
Control type roadside Lack of records.. ] Vehicle

One may also set the export directory from Controls menu window.
After command is triggered, Program settings window shall be displayed, where we may enter

in any other location of choice, or with the use of the |Z| icon, choose another directory.
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Main directory:

C:\Usersiusername\Documents\Controls E]

Import directory

C:WUsersiusername'Documents \Contrals\Impart E]

Export directaory

C:\Usersusername\DocumentsiControls\Export E]

| cancel |

/4
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After exporting if finished, the TachoScan Control software shall save the file in a stated directory
with a name containing a given number of control with *.zip extension. This file shall contain all of

the data from the performed control.

8. Unlocking and editing of control

In order to view or edit a given already performed control (in the archiving module it may be an
imported control), from the Control menu one should select the command: Edit/view selected

control.

p
‘= TachoScan 2.1 Control

Control | Data Reports Document Company Vehicles Drivers  Settings  User Help
Retrieve data

-

View data Analysis

MNew control

Edit current control parameters

||-==|\| 1=

Edit/view selected control b

Delete control

Archives

Export selected controls

Set directories 001-2008-1234-1234 Cargo goods

Exit the program Alt+X 25-04-2008 Registration naticn current country

Company Transport CO Type of road

[ESEEYESE

g |O-0.

Driving tim
Recording

Driver

Alternatively, we may use relevant option from Controls menu.

After making our choice, Select control window shall be displayed. We mark, then, a given required

oK
control and press .
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If the control is locked, then, we unlock it SOLELY for previewing — data editing is not possible, here.

In order to narrow down a given number of controls being displayed on the list, expanded filtering
system to the right of the window may be used.

Edit control data

In the Control menu, select: Edit current control parameters:

Control | Data Reports Document Company Vehicles Drivers Settings User Help

Retrieve data View data Analysis

p B 8§ 8550 b | S)S!

MNew control

Edit current contrel parameters Q

m | O 0.

Edit/view selected control

Delete control

Archives

Export selected controls

Set directories 001-2008-1234-1234 Cargo goods Driving tim

Exit the program Alt+ X §-04-2008 Registration nation current country Recording

Company Transport CO Type of road Driver

The following window shall appear:
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i B
EEEI

Mew control parameters

Mumber Date
|0001-2008-1234-1234 | = |m042008 |

Company name
ITransport co ‘

Cargo Controlled period:
' qonds [v] 13062005 + - 03-122008 ~

(™) control in the premises

W

@) roadside check

Driver's last and first name Vehide reg. no

Kowalski Jan w MNOL11CF

Co-driver's last and first name Registration nation
Bartosik Artur - | ather EC county

Type of road Type of tachograph

[=] |

Lack of records for other work andfor availability

Driving and warking time records

° oo W &

Recording equipment: incorrect functioning, misuse
Time zone:
[UTC+1 (Czech Republic, Germany, Poland, Slovakia, Austria, France, Italy) -

Average weekly working time ’ Define periods

o | [ conel |

When the "controlled period" is changed, it is necessary to download the data from driver's card and/or
digital tachometer again and then to reanalyze the drivers' infringements.
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In order to begin editing a locked control, from Control menu we opt for the command
Edit/view selected control, and then, we right-click with the mouse on the selected control and
opt for Unlock and edit the control (fig. ci-dessous).

& Select control

Find according to
Selected control data
Control o 000120081234 1234
C:\Usershtpenkals\DocumentshControls 200850l 0001 -2008-1234-1234
Filter of a date
all

[0 fomts

[ — S—
Number Date

From 26-07-2014

Company Driver
0001720087123+1234§370+2003 Transport CO  Kowalski Jan
Tit []26-08-2014

Co-driver

Filter of a company

[ all

Vehide  Control type Inspector
NOL11CF roadside

Inspector ID  Exporte Locked

Analyser Frank  1234-1234 No
Unlock and edit the control |
ks

-
26-08-2014

Filter of a vehicle

infringements.

After generating Infringements and manipulations report, you can change the status of

9. Generating reports

A report can be generated in two ways:

-

Q-

€
Rys. Paseknarz dziowy okna

o ﬁl - (fig. ci-dessus) - Generate and close - when the report is displayed, the window from

which the report was generates will be closed;

o BB Generate - when the report is displayed, the window from which the report was
generates will still be visible,

This option is recommended when displaying several reports of the same type — then, there is no need to close
the report preview window to display the same report, for example, for another driver or period.
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